Valkommen till ClaroRead

=

Vdlkommen till ClaroRead. ClaroRead ar skapat for att géra det enklare for dig att arbeta
med din dator genom att fa den att tala och géra det enklare att lasa. Det &r néra
integrerat med Microsoft™ Word® for att stédja dig nar du jobbar med din text men

hjalper dig aven med webbsidor och e-post samt mycket annat du kan vilja géra med
din dator.

ClaroRead tillfor kraftfulla talfunktioner som I3ter dig lyssna pa all information som visas
pa din datorskdrm. Den kommer dven med flera enkla sétt att géra text tydligare och
lattare att Iasa. Vi har aven inkluderat anvandbara rattstavningsverktyg, for att hjalpa
dig skapa korrekta dokument.

ClaroRead fungerar med alla program pa din PC. ClaroReads tydliga verktygsrad kan
|&sas till en position, dockas till skdrmens évre kant eller kan ldmnas flyttbar pa@ skdrmen
beroende pa vad som passar dig bést.

ClaroRead Pro verktygsrad
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ClaroRead Plus verktygsrad

% ClaroRead Plus V5 = | 6 2|

C-mal @ bt P 08

Skanna Spela Stopp Typsnitt  Avstind Homofoner Kontroll  Ordprediktion  Spara Extra Instéliningar Hjflp Sting

ClaroRead Standard verktygsrad
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ClaroRead oversikt

ClaroRead erbjuder en lattlast flytande verktygsrad som laser sig till det programfénster
som for tillfallet &r aktiverat. Du kan enkelt ldgga till och ta bort knappar fran denna
verktygsrad. Hela listan med knappar beskrivs i nasta avsnitt, ClaroReads
verktygsknappar.

Talfunktionerna i ClaroRead ar kraftfulla. En av de viktigaste fordelarna med ClaroRead
ar att programmet kan ldsa upp menyer, knappar och knappbeskrivningar samt all text
som visas pa skarmen. Programmet kan omedelbart ldsa upp vilken text som helst som
du markerar med musen. Det ldser ocksa upp bokstéver, ord och meningar medan du
skriver.

ClaroRead finns i tre versioner (I Sverige finns bara Pro och Plus) - ClaroRead Standard,
ClaroRead Plus och ClaroRead Pro. Pro och Plus versionerna har en inbyggd
skanningsfunktion dar du kan skanna fran papper eller fr&n en PDF fil (Optical Character
Recognition eller OCR). Pro versionen ger dig stérre kontroll éver din skanning.

ClaroRead Pro verktygsrad
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ClaroRead Plus verktygsrad
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ClaroRead Standard verktygsrad
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ClaroReads verktygsknappar

Verktygsraden |3ter dig anvanda ClaroReads kraftfulla funktioner ndr som helst utan att
de ar i vagen for dig.

Du kan minska den yta som verktygsraden tar upp genom att ta bort knappar samt
genom att minska pa verktygsradens storlek. se Visa.

-

SPEd |Knapparna Spela och Stopp

Med knappen Spela bérjar ClaroRead att tala:

For att Iasa Microsoft Word, placera markéren i borjan av texten du vill fa uppléast.
Klicka p& knappen Spela for att lasa fran markdrens position och framat. Se Fa
Worddokument att tala.

For att fa webbsidor i Internet Explorer upplasta, klicka med musen déar du vill att
upplasningen skall bérja. Klicka sedan pa Spela for att paborja upplasningen. Se
Upplasning av webbsidor.

For att |1dsa PDF filer i Adobe Reader, placera markdren i bérjan av texten du vill fa
upplast. Klicka pa knappen Spela for att |dsa fran markdrens position och framat. Se Fa
PDF Filer att tala.

I andra program kommer ClaroRead att lasa upp det som finns i urklippshanteraren,
Markera bara texten, kopiera och klicka pa& Spela fér att héra den. Se Upplasning i andra
PC-program. ClaroRead ldser upp allt du markerar med musen s3 du kan fa e-post
och pdf-filer upplésta utan att ens klicka pa Spela!

Mer om ClaroReads talfunktioner.

Stopp [Klicka pa Stopp for att fa ClaroRead att sluta ldsa. Du kan dven klicka med musen
(var som helst) eller tryck p@ Control-knappen eller klicka pd F8 for att stoppa
ClaroReads uppldsning.

Du kan andra hur ClaroRead talar i Installningar for Tal och Avancerade installningar.

Knappen Typsnitt

Knappen Typshitt |3ter dig snabbt andra typsnitt i ett helt Microsoft Worddokument till
ett av tre mer lasbara och populara teckensnitt, Trebuchet MS, Microsoft Sans Serif eller
det specialdesignade Tiresias. Du kan enkelt dka eller minska storleken pa text i hela
dokumentet eller bara pa en markerad del av det. Storleken pa texten kan 6kas eller
minskas i Internet Explorer. Du kan dven &ndra fargen pa ett helt dokument eller delar
av text i Microsoft Word. Mer om instédllningarna for teckensnitt.
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| Avstand |Knappen Avstind

Att andra avstdndet mellan bokstéver, rader och stycken &r enkelt med ClaroRead.
Anvand knappen Avstdnd for att valja ett utseende pa texten som passar dig. Denna
funktion kan anvandas i Microsoft Word och Internet Explorer. Mer om
avstandsinstallningarna.
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Homofoner

Knappen Homofoner

Nar du arbetar i Microsoft Word, klicka med musen i det stycke dar du vill séka efter
homofoner. Klicka p& knappen Homofoner for att fa alla homofoner i stycket
markerade. Homofoner &r ord som uttalas likadant men skiljer sig at i stavning,
betydelse eller ursprung. Ett exempel pa ett par av homofoner ar hjul och jul. Mer om
installningarna fér homofonkontroll.

oy

Kontroll

Knappen Kontroll

ClaroRead har en integrerad funktion fér att kontrollera ord och dokument. Vi har
koncentrerat oss pa att samla rittstavningen, synonymordboken och en separat
homofonkontroll under en enda knapp, Kontroll. Mer om Kontrollera.

Ordprediktion|Knappen Ordprediktion

Ordprediktion kan vara ett mycket anvandbart verktyg. Ordprediktionen i ClaroRead
innehaller de vanligast férekommande orden i det svenska spraket. Du kan &ven léra
ordprediktionen att anvénda sig av ditt eget ordférrad, antingen fran ett dokument eller
nar du skriver. Mer om ordprediktion.

Knappen Spara

Du kan konvertera text i ett 6ppet Microsoft Worddokument eller ndgon text du kopierar
in i Urklippshanteraren (t.ex. frdn en webbsida) till en ljud- eller videofil som sedan kan
sparas pa din dator. Klicka pa knappen. Spara i Microsoft Word och det aktuella
dokumentet sparas, eller valj text och kopiera in den i urklippshanteraren nar du har
andra textkallor. Mer om att spara som ljudfil.

AFS

Exira |Knappen Extra

Detta ar en anvandbar lank foér att starta ett antal andra utvalda program. Mer om Extra.



Instaliningar [Knappen Instéllningar

Knappen Instédllningar dppnar dialogrutan Installningar dar du kan andra alternativ och
installningar fér ClaroRead, inklusive Tal, Visa, Ordprediktion, Kontroll och Skanna. Mer
om Installningar.

Skanna |Knappen Skanna

Med Skanna kan du ldsa in pappersdokument (bdcker, tidningar, handlingar) med en
vanlig skanner och automatiskt omvandla dessa till text (med hjalp av OmniPages
ledande OCR-motor) i Microsoft Word. Texten kan sedan redigeras och ldsas upp av
ClaroRead. PDF-filer kan ocksa dppnas i Word, vilket gor dem 3tkom|iga for ClaroRead.
Du kan aven skanna direkt till en fil i stallet for till Word. Mer om skanning.



Flytta och L3sa ClaroReads verktygsrad

L3s verktygsraden till aktivt fonster

Som standard |3ser sig ClaroReads verktygsrad till det fonster som for tillfllet &r aktivt
och flyttar runt allt eftersom du byter program. Det I3ser sig alltid till det évre hogra
hérnet pa fonstret sa att du fortfarande kan anvanda programmet utan att ClaroRead &r
i vagen men fortfarande erbjuder alla verktygsradens funktioner.

Du kan andra detta i installningar under fliken Visa.

Las verktygsrad till aktivt fonster
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Flyttbar verktygsrad

Det kan handa att du vill att verktygsraden skall bete sig som ett vanligt fonster, fast det
kommer alltid att vara dverst sa att du alltid kan anvdnda det. Du kan fa verktygsraden
att "flyta" s3 att den har en namnlist som vanligt och du kan flytta runt den. Oppna
fliken Visa i Installningar och avmarkera kryssrutan "Las verktygsrad till aktivt fonster".

|:| Las verktygsrad till aktivt fanster
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Ldsa verktygsraden till skarmens 6vre kant

Du kan I8sa verktygsraden till skarmens 6vre kant. For att géra detta maste du forst
gora verktygsraden flyttbar genom att avmarkera L3as verktygsrad till aktivt fonster i
fliken Visa i Installningar.

|:| Las verktygsrad till aktivt fonster

Nar verktygsraden ar flyttbar, klicka pa dess namnlist och dra den till skdrmens 6vre
kant. Slapp verktygsraden och den kommer att 1&sa sig till skdarmens 6vre kant.
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Klicka p& knappen Losgér for aterga till en flyttbar verktygsrad.
Minimera eller gom verktygsraden

Du kan délja ClaroRead verktygsrad genom att minimera eller gdmma den. Manga av tal
och prediktionsfunktionerna kommer fortfarande att fungera, som till exempel att tala
nar du valjer med musen eller placerar muspekaren éver webbsidor.

Det enklaste sattet att gora detta &r att trycka pa paustangenten, denna far
verktygsraden att visas eller déljas. Du kan aven délja verktygsraden genom att klicka
pa minimeringsknappen nér verktygsraden &r flyttbar:

Sl 7 @‘l

ClaroRead kors fortfarande i bakgrunden, indikerat med den lilla ClaroRead ikonen som
visas i systemfaltet nara din klocka, vanligtvis i det nedre, hdgra hérnet av din skarm:

Denna ikon ger dig ytterligare ett satt att visa eller délja verktygsfaltet. Om du
vénsterklickar pa ClaroReads ikon kommer verktygsraden att visas. Om du hégerklickar
pa ikonen férsvinner verktygsraden.



Tal

ClaroReads férmaga att fa din dator att tala ar en av dess viktigaste funktioner.
ClaroRead anvinder sig av hogkvalitativa syntetiska roster som Realspeak fran ScanSoft
(nu Nuance) och résterna fran Acapela. ClaroRead kommer ocksa att anvédnda sig av alla
andra syntetiska roster som &r installerade pa din dator férutsatt att de féljer SAPI5-
standarden.
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SPEld |Knappen Spela eller tangenten F7 startar talet i Word, Internet Explorer eller i
Adobe Reader. Dessa knappar starta ocksa talet fran Urklipp. Andra sétt att starta talet
godrs med musen eller tangentklick.

Med ClaroRead far du féljande breda utbud av talfunktioner:

Fa Microsoft Worddokument att tala genom att klicka med musen dar du vill bérja och
sedan klicka pa knappen Spela. Du kan dven fa texten upplast med markdrmedfdljning.
Mer om markdérmedféljning.

F& webbsidor att tala genom att halla muspekaren 6éver dem eller klicka bara pa knappen
Spela [eller F7].

Fa Adobe Reader PDF filer att tala genom att klicka med musen dar du vill bérja och
sedan klicka pa@ knappen Spela. Du kan dven fa texten upplast med markdrmedfdljning.
Mer om markdérmedféljning.

Fa valfri text fran valfritt PC-program upplast direkt nar du markerat den med musen.
Det &r ett fantastiskt verktyg for att f& dokument, webbsidor och e-post att "tala".

Med Tangenteko far du bokstéver, ord och/eller meningar upplasta medan du skriver. Pa
sa satt far du omedelbar bekréftelse pa att du skrivit just det du ténkte skriva!

Automatiskt f8 manga menyalternativ, verktygstips och "objekt" uppldsta genom att
placera muspekaren 6ver dem.

Gor ljud- och videofiler fran Worddokument eller webbsidor for att sedan kunna
lyssna/titta pa dem pa din PC, mobiltelefon eller mediaspelare. Du kan &ven féra éver
filerna fran din dator till en portabel enhet. (Du anvénder enhetens egen mjukvara for
att foéra over filerna till enheten).

En Talande minirdknare ger rést at Windows Kalkylator.
Fa en Talande upplagsbok.

Du kan nar som helst fa datorn att sluta prata genom att klicka p& knappen CTRL, F8
key eller genom att klicka med musknappen.

Se Instédllningar for Tal och Avancerade installningar.



Fa Worddokument att tala

Anvanda Spela

Starta Microsoft Word och dppna det Worddokument du vill fa upplast eller skriv en ny
text.

Klicka med musen i dokumentet. ClaroRead bérjar lasa fran textmarkdrens position.
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=Pl |Klicka pa den grona Spela-knappen pa verktygsraden eller anvéand F7 tangenten.
Texten blir upplast for dig och markeras vartefter den lases upp. Se mer om
Markérmedféljning.

Valkommen till ClaroRead. ClaroRead ar skapat for att
gora det enklare for dig att arbeta med din dator
genom att fa den att tala och gora det enklare att lasa.

Anvand Las enstaka ord hall ner Ctrl och peka

Genom att markera kryssrutan for "L&ds enstaka ord hall ner Ctrl och peka" i fliken Tal
kommer ClaroRead att bara lasa upp ett specefikt ord i taget. Placera muspekaren dver
ordet och hall ner CTRL tangenten.

Markera text med musen och f§ tal

Markera den text du vill ha upplast med musen for att fa tal utan markérmedféljning.
Det kan vara bra om du bara vill ha en liten del upplast. Se Avancerade instdllningar.

Stanna efter mening

I installningarna under fliken Tal kan du markera kryssrutan i Stanna efter mening for
att gora sa att ClaroRead ldser upp en mening i taget. For att ldsa ndsta mening maste
du klicka pa knappen Spela igen.

Har du inte markerat "Stanna efter mening" kan du lasa nasta mening med Shift och F7
eller genom att hélla ned shift nar du klickar p& knappen Spela.

Anvand piltangenterna
(]

s JClaroRead kan l&sa texten under markdren nar du flyttar runt i en
textruta, inklusive Microsoft Word, med hjdlp av piltangenterna upp/ned/vanster/hdger
pa ditt tangentbord (i stallet for din mus). Aktivera detta genom att kryssa i

"Piltangenterna" i Avancerade installningar.



: 4Nar du forflyttar dig med upp- eller nedpilen, laser ClaroRead upp hela raden med
text. P& detta satt kan du fa ett dokument uppléast for dig rad foér rad genom att
anvanda piltangenterna.

; |3l ned Ctrl samtidigt som du trycker ned héger eller vanster piltangent
for att fa nasta ord upplést.

Tryck pa hoger eller vanster piltangent for att héra en bokstav i taget.

Ctrl tillsammans med pil upp- eller ned forflyttar dig ett stycke i taget och ldser ocksa
upp dem.



Upplasning av webbsidor

ClaroRead gér att du latt kan fa de flesta webbsidor upplésta.

Peka med musen

Du kan f3 ldankar, objekt, bilder och text uppldst genom att bara pd peka med musen
Over det du vill ha upplast. Detta fungerar i Internet Explorer, Mozilla Firefox, Safari och
Opera. Se Avancerade installningar.

F3 markerad text upplast

Markera en text for att fa den upplast utan markdrmedfdljning. Detta kan du anvédnda
ifall du bara vill héra en del av en text. Detta fungerar ocksa i de flesta webblé&sare -
Firefox, Internet Explorer, Chrome, Safari eller Opera. Se Avancerade installningar.

Anvand Spela knappen (Internet Explorer)

-

5P |Om du Klickar pa den gréna knappen Spela eller anvanvder F7 kommer websidan
att bli upplast fran borjan till slutet i en ordning som ar relaterad till hur sidan ar

uppbyggd.

Om du klickar med musen i bérjan av ett stycke som du skulle vilja ha upplast, visas en
"virtuell markor", Se nedan:

Ylkkommen till ClaroRead. ClaroRead ar skapat for att gdra det enklare for dig
tt arbeta med din dator genom att f3 den att tala och géra det enklare att
da. Det dr ndra integrerat med Microsoft™ Word® for att stédja dig nar du
pbar med din text men hjdlper dig aven med webbsidor och e-post samt
cket annat du kan vilja géra med din dator.

Klicka p& den gréna knappen Spela eller F7 s& startas upplasningen och meningen
markeras med den firg du har valt. ClaroRead fortsatter att |&sa till du klickar pa Stopp,
CTRL tangenten eller anvander F8.



Upplasning av PDF-filer

PDF filer i Adobe Reader eller Adobe Acrobat fungerar som dokument i Microsoft Word.
Du kan markera text for att lyssna pa ett speciellt stycke, anvdnda CTRL och Peka for att
héra ett speciellt ord och klicka p@ Spela for att hdra hela dokumentet med
markdrmedfdljning precis som i Word.

Notera, PDF filer &r mycket komplexa sa det kan ibland stalla till problem fér ClaroRead
(och for aven andra hjalpmedel). Se PDF och tillganglighet féor mer information.

Det finns manga satt att géra Adobe Reader eller Acrobat mer anvandbart. Se hjélpen
for Adobe Reader och Adobe Acrobat for mer information.

Anvanda Accessible PDF lasare

H
_/LF Accessible PDF

Accessible PDF &r ett gratis Extra program fér ClaroRead som tillater dig att importera
vissa PDF dokument till ett webbsideformat. For att l&sa accessible PDF filer, klicka pa
knappen Extra i ClaroReads verktygsrad och valj "Accessible PDF". Accessible PDF
startas och du kan valja vilken PDF fil du vill 6ppna. Nar den ar dppnad kan den visas
som oformaterad text eller som i en webbsida. ClaroRead kan sen anvéndas for att fa
text upplast.

[A] Accessible PDF = | B )
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Upplasning i andra PC-program
ClaroRead kan anvandas i de flesta program. Anvand nagon av féljande alternativ.
Las vid musmarkering

ClaroRead laser upp all text du markerar med datormusen. For att gora detta, markera
en text med din mus:

VEILGInln RN ETG s M ClaroRead ar skapat for att
gora det enklare for dig att arbeta med din dator
genom att fa den att tala och gora det enklare att lasa.

Texten boérjar ldsas upp direkt nar du slapper musknappen.

Vill du inte att text skall lasas upp nar den markeras med musen, kan du stédnga av
funktionen i Avancerade instdllningar.

Lads innehdllet i Urklipp

Om du klickar pa knappen Spela eller anvdnder F7 nar du inte &r i Internet Explorer,
Microsoft Word eller Adobe Reader ldser ClaroRead upp innehallet i Urklipp.

Du kan ocksd markera text i ndgot program och kopiera texten vanligt i (Redigera
menyn eller med CTRL+C) och klicka sedan pa Spela eller anvénd F7 i ClaroRead.

Som vanligt stoppar du talet genom att klicka p& knappen Stopp eller anvénder F8.
Las ord Ctrl och peka

Markera rutan "Las ord Ctrl och peka" i installningar i fliken Tal om du vill kunna lyssna
pa ett speciellt ord i taget. Hall ner CTRL tangenten och peka pa ett ord. ClaroRead laser
da upp detta ordet.

Nedan &r en lista pa vanliga program som Ctrl+peka fungerar med:
Internet Explorer

Microsoft Office (inklusive Word and Outlook)

Mozilla Firefox

Adobe Acrobat Reader

Windows Mail/Outlook Express



Typsnitt

al.

Typ=nitt

Nar du arbetar i Microsoft Word och Internet Explorer kan du med ClaroRead
dndra teckenstorleken. I Microsoft Word kan ClaroRead ocksa enkelt dndra typsnitt och
farg pa hela dokumentet. Klicka ndgonstans i det dokument du vill &ndra och knappen
Typsnitt aktiveras. Klicka p& knappen Typsnitt och féljande meny visas:

1 T Oka textstorlek

l T Minska textstoriek

EI Tiresias PCfont

EI Trebuchet MS

EI Wicrosoft Sans Serif

‘_I Teckenfirg 3

F Bakgrundsfirg 3
&

Du kan &ndra pa textens storlek i dokumentet genom att klicka pa Oka textstorlek
eller Minska textstorlek. Detta éndrar storleken i steg om tva punkter i taget. Fran
som minst 8 punkter upp till 100 punkter.

Du kan dndra vilket typsnitt som anvands i dokumentet till ett av tre vanligen
forekommande (Times New Roman, Trebuchet MS och Microsoft Sans Serif). Du kan
med Programmet Avancerade installningar éndra vilka tre typsnitt som listas.

Du kan med fargpaletten @ndra firg pa texten i ett helt dokument. Detta &ndrar
installningen for bakgrundsfarg i Windows.
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Avstand
|

—

Avstand

Andra tecken-, rad- och styckeavstand i Microsoft Word kraver en del ingdende
kunskaper och ganska manga tangenttryckningar om du anvénder menyerna i Word.
Genom att fokusera pd de mest anvdnda funktionerna gér ClaroRead det enkelt att
dndra avstanden i text i Microsoft Word och Internet Explorer. Om du klickar p& knappen
Avstand nar du arbetar i Word visas féljande meny:

AV Andra avstand mellan tecken
-—

]ﬁ Andra avstand mellan radsr

I_:]. Andra avstdnd mellan stycken

Andra avstand mellan tecken 6kar avstandet mellan bokstdverna med 1 punkt, sedan

2 punkter och till sist 3 punkter. Klickar du pa den igen aterfar bokstdverna normalt
avstand.

Andra avstdnd mellan rader 6kar radavstandet fran 1 rad till 1,5 rad, sedan till 2
rader och till sist tillbaks till 1 rad.

Valkommentill ClaroRead. ClaroRead ar skapat for att
goradet enklare for dig att arbeta med din dator

genom att fa den att tala och gora det enklare att lasa.

Andra avstand mellan stycken andrar avstandet fran slutet av ett stycke till borjan pa
nasta fran 0 punkter, 6 punkter, 12, 18, 24 och sedan tillbaks till 0 punkter.



Homofonfunktioner

Homafoner |Klickar du pa knappen Homofoner i ClaroRead nar du jobbar i Microsoft Word
visas foljande meny:

= Viza homofoner

X Ta bort markering av homofoner

For att s6ka efter homofoner i en mening klickar du i den med muspekaren, du kan aven
markera text med musen. Klicka pa Visa homofoner eller valj F10 for att visa alla
homofoner i meningen eller den markerade texten. Homofoner ar ord som uttalas
likadant men skiljer sig ati stavning, betydelse eller ursprung. Ett exempel pa ett par av
homofoner &r "hjul" och "jul". ClaroRead markerar homofonerna med bla text, men du
kan @ndra detta i Instéllningar for homofoner.

Du kan hindra en homofon att visas i Instéllningar for Homofoner. Du kan ocksa redigera
homofoner under fliken Homofoner i Programmet Avancerade instéllningar.

N&r homofonerna visas, klicka med muspekaren pa ett av dem och klicka sedan pa
knappen Kontroll. I kontrollfénstret visas fliken Homofoner. Du kan sedan ga igenom alla
homofoner i meningen eller den valda texten med knapparna Nasta, Ignorera alla eller
Andra. Detta |3ter dig kontrollera homofoner fér mer &n ett ord i taget. Se
Kontrollfunktionen fér mer information.

Du kan ta bort markeringen av homofoner med menyalternativet Ta bort markering av
homofoner eller anvanda F11.



Kontrollfunktioner

oby

Kontroll

Med ClaroRead far du en enda knapp som du kan anvanda fér att kontrollera
stavningen, forklaringar, definitioner, alternativ och identifierar homofoner med
forklaringar.

Att anvanda

Markera den text som du vill géra en stavningskontroll pa. Du kan markera text i vilket
program som helst te.x en web browser som Internet Explorer eller ett email program
som Outlook.

o)l 9 O & ¥ 8y 7 Projekt - Message (H... SIS

— ET

"‘_j" Message Insert Options Format Text Add-Ins g
Va2 )
3 ==
Pasie Basic | Names Include Options Spelling
.4 Text = ® ” = ®
Clipboard ™ Proofing
This message has not been sent.
| To.. professor @universitet.se
=5l
=" | Eitin
Send
Subject: Projekt
&)
Kara Professor, -
hied vanlig halsning,
Alasdair
-

A

Klicka p& kontroll knappen p& ClaroroReads verktygsrad. Om det finns stavningsfel
kommer kontrolldialogen att visas:
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mat -

Andra -

Alternativ (Synonymer)

3 | centrum indra alla Tnnehall
i mitten ————— | @ forsokte ldmna in mitt uppdrag #
. Ignorera mer ingen
precis
Ignorera alla
I Avbryt | Ku:untrnllera:ltlivnlngen pal | 7 Sk e it

XX
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Ordet som ska korrigeras visas i "Ord" rutan.

Forslagna stavningsalternativ visas i forslagslistan. Klicka pa nagot av dessa alternativen
- det dversta blir automatiskt valt. Detta uppdaterar resten av dialogen.

Nedanfor forslagslistan finns en synonymlista. Detta ar en lista 6ver andra ord som
betyder likadant som valt ord.

Om det finns en bild kopplad med det valda ordet visas den till hoger.

Den markerade texten visas med fet stil i innehdllsrutan nere till hdger. Denna visar dig
hur alternativet kommer att se ut i orginal texten.

Nere till héger finns "SI& upp" knappen som letar upp det valda ordet pad internet s3a att
du kan far mer information om det.

Nere till vanster finner du avstavningsknappen.

Du kan peka med musen pa vilket av orden eller meningarna du vill fér att lyssna dig
fram till vilket ord du vill anvénda. Du kan stanga av denna funktion med sténg av tal

&

knappen i 6évre delen:

Du kan ocksa géra denna dialog enklare genom att gémma definitioner, innehall och SI3
upp knappen genom att klicka pa pilen for att dppna och stinga pa den hogra sidan av

©

dialogen. Det som aterstar nu &r "Férslag" och "Synonymer".



Genom att klicka pa andra rattas ordet till ditt val och gar till nasta felstavat ord. N&r du
har gatt igenom alla felstavningar stidngs dialogen och dina andringar klistras in och
ersatter de felstavade orden. Om detta av ndgon anledning inte fungerar sa var inte
orolig: din réttade text finns i urklippet s& du kan manuellt kan klistra in texten. Om du
vill angra dina andringar klickar du p& Redigera och Angra (eller hall ner CTRL och Z) for
att angra alla dina andringar.

Denna funktion kraver att Microsoft Word &r installerat. Vilken version som helst gar att
anvanda men med Word 2007 and 2010 kommer du att fler felstavningar upptackta.

Andra funktioner i Microsoft Word

I Microsoft Word finns det mer funktioner for felstavningskontroll. Istallet féor markera
mycket text eller ett stycke kan du bara sétta markéren i ett ord och klicka pa kontroll.
Nu far du all information om ordet som finns tillgangligt. Upp till tre flikar kan synas:

Stavnings fliken visas ifall Microsoft Word upptacker felstavning av ordet.

Homofon fliken visas ifall ordet &r en homofon - om ordet Iater precis som ett annat ord
som "hjul" och "jul". Se Homofoner for mer information.

Forklarings fliken visar mer information av ordet inkluderat andra ord som kan vara ett
alternativ for dig.

Du kan markera ett stycke text precis som innan. Om du valjer ett stycke och sedan
klickar p& Kontroll far du en kontroll bara pa det valda stycket och inte hela texten i
dokumentet.

Du kan &ven vélja att kontrollera hela dokumentet pa en gang.



Ordforklaringar

Med ClaroRead féljer talande ordférklaringar som laser upp definitionen av alla ord i alla
program.

Hall ner CTRL tangenten och peka med musen pa ett ord. Ett fonster med ordférklaringar
kommer nu att visas:

frimsta delen av fartyg, i ldge pd framsidan av,
duglig, av faljande orsak

Du kommer att héra ordet du pekar pa sa lange du har Las ord ctrl och peka aktiverad.
Definitionen visas och du kan lyssna genom att peka med musen.

Du kan sl& upp ordet pa internet genom att klicka pa Elsis upp knappen i hégra hérnet.

Du kan klicka pa ordet for fa det definerat.

Fonstret kommer att visas tills du klickar pa ESténg knappen. Du kan ocksa dra
fonstret till den plats pa skdarmen dar vill ha den. Du kanske vill att fonstret alltid ska
synas pa en plats: Vé&lj da att bocka i "Visa alltid ordférklaringar" i Stavnings fliken. Om
du vill avaktivera hela ordlistférklaringen sa& bockar du av "Ordférklaringar" pa samma
flik.

Notera att fér att spara utrymme sa syns endast tre rader i fonstret. Skrolla ner for att
l&sa allt i valdigt Ianga definitioner



Ordprediktion

Ordprediktion|ClaroRead kommer med en funktion fér ordprediktion, ndgot som kan vara
anvandbart for vissa datoranvandare. ClaroRead anvander sig av en basordbok (som kan
dndras) pa 1000 eller 3000 av de vanligaste forekommande orden i det svenska spraket.

Du kan andra mellan basordbdckerna i fliken Ordprediktion. Fler prediktionsordlistor kan
skapas med hjalp av Programmet Avancerade installningar.

Aktivera ordprediktionen

Ordprediktionen ar avaktiverad fran bérjan nar ClaroRead ar installerat. For att aktivera
ordprediktionen, klicka pa knappen Installningar pa ClaroReads verktygsrad, Valj fliken
Ordprediktion och klicka pa "Anvand ordprediktion":

Installningar

=

f Visa -I?i Ordprediktion

3 Tal il“# Skanna

Anpassa lexikon Fanster med predikiiva ord

_aE;,- Stavning

[¥] Laga automatiskt till nya ord

7 =ar en rattstavningskontrall innan nya ord
— ldaoas till " Lista ord alfabetiskt

[¥] La arke till anvand ordféljd )
A TEESE e S @ Lista ord efter sannolikhet

[¥] sortera utifrdn antalet anvinda ord

<

[

[ | Spara ardbok nar du avslutar (/] Anvind ordprediktion

Ordfil .‘_ | Text :d‘_|

|Drd|ist.a med 1000 ord [Svenska) v| Teckenfdrg Bakgrund

© @

oK Avbryt

claro

Du kan ocksa lagga till knappen Ordprediktion pa ClaroReads verktygsrad via fliken Visa.
Ordprediktionen slas pa och av genom att klicka pa knappen.

Anvidnda ordprediktionen

Nar ordprediktionen ar aktiverad visas prediktionslistan automatiskt bredvid markéren
nar du skriver. Fonstret visas bara nar ord foresl3s.




F1 de
F2 det
F3 den
F4 du
F& dar

For att védlja ett av de féreslagna orden i prediktionslistan, tryck pa motsvarande
funktionstangent. F1 ar det forsta féreslagna ordet och F5 ar det femte och sista ordet.
For att anvanda de kommandon som vanligtvis dar kopplade till F1-F5. Du kan aven klicka
med musen pa valfritt ord i prediktionslistan. The word will then be completed.

Placerar du muspekaren pa ndgot av orden i listan kommer ClaroRead att ldsa upp ordet.
Konfigurera ordprediktionslistan

Du kan stoppa ordprediktionslistan att félja markdren nar du skriver och istallet valja att
fa en fast position. Aktivera ordprediktionen och bérja skriv till listan med ord dyker upp.
Hogerklicka pa listan. Detta l&gger till en bld ram runt den rutan med ord i. Klicka i den
blda ramen och dra listan till en plats som du féredrar. Har kommer den att vara till du
dndrar pa den.

F1 de
F2 det
F3 den
F4 du
F& dar

Det finns andra instéllningar du kan goéra nar det galler ordprediktion: se Installningar
for ordprediktion och Programmet Avancerade installningar.

Anvinda F1-F5 i andra program

Om ClaroRead anvander F1, F2, F3, F4 och F5 for prediktion kan du inte anvanda dem i
andra program for att till exempel starta hjélp. Om du vill g& runt ordprediktionen och
anvanda funktionknappen i nuvarande program, klicka férst F6 first och sedan ditt val
mellan F1 till F5. Nu kan du skicka ditt kommando till nuvarande program.



Spara

I ClaroRead kan du valja spara text som ljud- eller videofiler.

Spara text som ljudfil

ClaroRead |ater dig spara texten fran ett Word-dokument eller text fran ndgon annan
applikation som kopierats till klippbordet, som ljudfil i formaten WMA, WAV eller Ogg.

Att spara som ljudfil kan vara en langsam process om det &r ett stort dokument. En
forloppsindikator visar hur 18ngt processen har framskridit. Den rést som anvands &r
samma som du valt pa fliken Tal under installningar.

Den rést som anvands &r samma som du valt pa fliken Tal.
Att spara text som ljudfil

I Microsoft Word eller i Adobe Reader : Oppna ett Word dokumentet eller en PDF-fil
som du vill konvertera till en ljudfil.

Hemsidor och annan text: G3 till hemsidan du vill konvertera till ljudfil. Markera
texten med musen, tryck pa Kopiera i Arkivmenyn eller CTRL+C. Texten kopieras till
Windows klippbord, det ar inget du ser.

P& ClaroReads verktygsrad klickar du p& knappen Spara, véljer Spara som ljudfil eller
oppnar Instéllningar pa ClaroReads verktygsrad och klickar pa fliken Tal och klickar pa

il

Spara sam
[judfil

knappen Spara som ljudfil:

Foéljande dialogruta visas. Ge ljudfilen ett namn och tala om var du vill spara den.

[ £ Spara som Lﬁ

.unul |; DESlL'tEIFl k - | iy | | Segrch i)
File name:; Valkoernmen.swma G
Save as type: |WMA Files (*.wma) v|

¥ Browse Folders | Save | | o |

Du kan sedan 6ppna ljudfilen med din Media Player eller féra 6ver den till en barbar
Mp3-spelare genom att anvanda programvaran som fdljer med spelaren eller annan
[@mplig mjukvara.



Spara text som videofil

ClaroRead |ater dig spara text som en videofil. I denna visas texten en mening i taget
samtidigt som den lases upp.

Att spara till en videofil:
For Worddokument: Oppna Worddokumentet som du vill konvertera till en videofil.

For webbsidor och annan text: G3 till hemsidan du vill konvertera till videofil.
Markera texten med musen, tryck pa Kopiera i Arkivmenyn eller CTRL+C. Texten
kopieras till Windows klippbord, det ar inget du ser.

Sedan

i

P& ClaroReads verktygsrad klickar du pd knappen Spara | SPara_|och véljer Spara som
videofil.

Programmet Spara till video startas nu. Du kan se texten som skall sparas och valja
videoformat, teckensnitt, textfarg, bakgrundsfarg, om du vill ha en ram runt texten och i
sa fall vilken farg det skall vara p& ramen. Mer information kan du hitta i Spara till videos
hjalpfil.

ig Claro spara till video —

Arkiv Enhet Format Instdllningar Hjalp

~Device i Text till video
: . = E" Walkommen till Claro Spara till video. ”
Phome slley. iPod Tauch —] E a . [ Kopiera eller skriv in texten du vill gdra
| Teckensnitt | Bakgrund om till en video. Klicka sedan pa Skapa!

[~ Férhandsgranska

Valkommen till Claro Spara till video.
Kopiera eller skriv in texten du vill
gora om till en video. Klicka sedan pa
Skapa!

d

Ram =
F - FF - X % %X ¥ 0@
< m = Skapa! .| Ehstra in | Hjalp Avsluta

Redo




N&r du har gjort instéllningarna for videofilen s klickar du p& knappen Skapa! Och
féljande dialogruta visas. Ge filen ett namn och ange var pa din PC den skall sparas.

-

= Save As

@u‘ﬁ‘lx Dezktop »

- | 5 | | Seqrch

File name: Valkornmen till Claro Spara till \mdwv

Save as type: | hMAY [rdw)

¥ Browse Folders




Skicka text till iTunes

Du maste ha iTunes installerad och fungerande pa din dator. Om det &r det far du pa
knappen Spara ett val att "Skicka till iTunes" nar du klickar pa den.

Om du ar i Microsoft Word eller Adobe Reader kommer nuvarande dokument att
anvandas eller delar av det om du har markerat en bit text i dokumentet.

En Skicka till iTunes dialog 6ppnar sig och fragar dig om sparnamn (titeln pa detta
dokument), albumnamn och artistnamn (oftast du sjalv).

-

Skicka till iITunes

Spar
Matematik

Album
ClaroRead

Artist
Michelle

Lo |

L

Texten blir konverterad till ljud och skickas till iTunes som konverterar det till samma
format som som nar man rippar CDs (AAC, MP3 etc.)

Du kan sedan l4tt hitta dina ljudfiler. Varje dokument blir ett spar. De ar grupperade i
album efter amne. Alla dina sparade ljudfiler samlas under ditt eget namn. Detta gor det
enklare att organisera och sparen blir férstas kopierade till din iPod.



ClaroRead Extraprogram

AFS

Extra |Med knappen Extra kan du snabbt starta ett antal andra utvalda program. Har du
nagot av féljande program installerade visas de i listan:

Talande kalkylator (en funktion i ClaroRead)

Accessible PDF reader (ett gratis verktyg fran Claro Software)
ClaroView

ScreenRuler

ClaroCapture

Claroldeas

AMIS Daisy Reader

Programmet Avancerade installningar

Lank till uppdateringar och extraprogram till ClaroRead

Talande minirdknare

-
[ Caleulator = =

Edit View Help

Backspace | | CE | | C

MC 7 8 3 £ sqrt

MR 4 2 6 * A

M5 1 2 2 - 14

ClaroRead far Windows Kalkylator att tala. Ange talen med det numeriska tangentbordet
och resultatet kommer att lasas upp for dig

Accessible PDF Reader

Accessible PDF &r ett gratis tillagg i ClaroRead som Iater dig importera atkomliga PDF
dokument som sedan kan ldasas upp av ClaroRead.



ClaroView

ClaroView &r ett program som |3ter dig &ndra fargton pa din datorskarm.
ScreenRuler

ScreenRuler ar en laslinjal som hjalper dig ldsa genom att forstora textstycken.
ClaroCapture

ClaroCapture fangar text och bilder fran olika kallor och sparar i projekt.
ClarolIdeas

Claroldeas later dig organisera och samla dina tankar med hjélp av en tankekarta.
AMIS Daisy Reader

Programmet Avancerade instdllningar

Har finns ytterligare funktioner och installningar for stavnings-, homofon- och
prediktionsfunktionerna i ClaroRead.

Lank till Uppdateringar och extraprogram

Detta ar en lank till uppdateringar och extraprogram dar du kan hitta uppdateringar och
nya extraprogram som har slappts.



Skanna

Om skanning

.
Skanna |Med ClaroRead kan du skanna in dokument i Microsoft Word eller spara dem som
filer. ClaroRead anvander sig av OmniPages OCR-motor (Optical Character Recognition).

N&r du skannar ett dokument hamnar texten i Word. Den kan da genast bli upplast med
ClaroRead eller sparas som ett dokument for att anvandas vid ett senare tillfalle.

I Word kan den inskannade texten redigeras sa att du kan klippa, klistra och kopiera text
till nya dokument i Word eller andra program.

ClaroRead kan ocksd omvandla text fran PDF, TIF och andra bildformat och p& s& satt
gobra aven dessa dokument tillgangliga.

Du kanske kan marka att PDF filer som kan bli lasta av ClaroRead blir battre upplasta
ifall du forst skannar dem och sen sparar dem som PDF filer. Det &r s3 for att processen i
ClaroRead ar optimerad att géra lasbara PDF filer.

Foér mer information om PDF, se Att gora tillgangliga PFD filer. For mer om installningar i
skanningen, se Skannerinstallningar.

Skanna till Word eller skanna till fil

Nar du skannar med ClaroRead kan du skanna direkt till det 6ppna Worddokumentet
eller spara till en fil - ofta till en PDF fil men ocksa till Word eller RTF for senare
redigering.

Om du har ett Word dokument 6ppet nar du startar en skanning kommer texten att bli
placerad dar du har din markor. Om du inte har ett 6ppet Worddokument blir du
tiIIfrégad att spara till en fil dar du kan valja ditt format (PDF, RTF, image...). Du kan
ocksa fa ditt sparade dokument att dppnas automatiskt om du vill - se
Skannerinstallningar. Om du har Férhandsgranska eller korrekturléas markerat kan du
ocksa valja mellan Word eller fil i dessa fonster.

Det finns fordelar med bagge:
Om du skannar och skickar till Word blir texten redigerbar.

Om du skannar och sparar som en PDF fil kan du fa en exakt kopia av original filen som
kan lasas med markérmedféljning.

Plus och Pro

ClaroRead Plus har en bekvam och snabb skanning. Du kan valja att skanna direkt till
Word eller skanna och spara det som Word. Du kan ocksd spara det som PDF, bildfil eller
som en textfil. Du kan ocksd anvédnda dig av ett féorhandsgranskningsfénster dar du kan
valja lasordning och ta bort sidor innan du konverterar det.

ClaroRead Pro har en mer kraftfull skannerprocess som ocksa innehaller ett
korrekturlasningsfonster dar du kan ratta till fel uppkomna i processen. Det finns ocksa



manga fler alternativ som ocksa inkluderar eBécker, |16senordsskydd och andra
funktioner.

Skanna fran papper

Du kan behdva kontrollera att skannern ar installerad korrekt innan du skannar férsta
gangen.

Om du skannar nar du jobbar i Microsoft Word, skickar ClaroRead texten direkt till Word.
I annat fall ges du moéjlighet att spara det skannade dokumentet som en fil.

Klicka pa knappen Skanna pa ClaroRead verktygsrad, och féljande meny visas:

F b Skanna fran papper
{ ', Skanna fran POFAi

Klicka p& Skanna fra&n papper och skanningen startar.

Se ocksa Férhandsgranskning och Korrekturldsning (endast Pro).
Skanna mer dn en sida
ClaroRead tar sa manga sidor som skanningen sander.

Programmet sager till nar du skall lagga in en ny sida i skannern:

F p n -
Fortsatt automatisk bearbetning &J

Vad vill du géra nu?

| Sluta ladda sidor |

I Laan till fler sidor J

e

Du far valet att fortsatta ladda in sidor eller sluta och g& vidare med skanningen.
Skanna fran PDF/Fil (Konvertera en bild- eller pdf-fil till text)

Detta ar anvandbart fér odtkomliga PDF filer som inte g&r att fa upplasta i Adobe
Reader, ClaroRead eller Accessible PDF.

Om du har ett Word dokument 6ppet nar du startar en skanning kommer texten att bli
placerad dar du har din markor. Om du inte har ett 6ppet Worddokument blir du
tillfrégad att spara ditt resultat till en fil.

Klicka pa knappen Skanna pa ClaroRead verktygsrad, och féljande meny visas:



I.- b Skanna fran papper
Il_ r Skanna fran POF/il

Klicka p& Skanna frdn PDF/Fil.

.

* L3sin POF eller bildfil

41 Downloads

Dropbox

m

| Recent Places

. Libraries

_-' Documents ) Misc

o Music
| Pictures
1| Tech

BE videos

#d, Homegroup =

File name:

o
@-uvl » Libraries » Documents » PDF Tests » - | +?|| Search PDF Te jol
Organize » Mew folder = | ™ Eﬂ .ﬂ.
I Favorites —  Documents library hessmacriiy S iner
s ——— Arrange by:  Folder
esktop I

1 Simple linear
Ad text.pdf

m

2 German with
columns and
pictures. pdf

Powerpoint-style
columns.pdf

~ | Alla bilder (pdf; gif: 1if; jpg; pog |

[ G B [ Goren |

Valj fil som ska 6ppnas.

Se ocksa Férhandsgranskning och Korrekturldsning (endast Pro).



Forhandsgranska

Som standard kommer ClaroRead att skanna direkt till Word eller spara till en fil s3 att
du kan arbeta med din text nar du vill. Om du vill ha mer kontroll éver skanningen kan
du anvanda funktionen Férhandsgranska.

I fonstret Férhandsgranska kan du ta bort de delar du inte vill skanna och stalla in
ldsordningen i resultatet. Lasordningen ar mycket viktigt fér PDF filer. Se Gor PDF filer
tillgangliga.

Fonstret Férhandsgranska visas om du har markerat "Férhandsgranska den inskannade
bilden" i Skannerinstallningar.

”
® ClaroRead Pro Forhandsgranskning

L4

‘5and till Word

-

Spara

8 bRy (g P
Wiyt e b bebing

@

s aiy ol by bgrer ion
Aud ther st shuare (o ik e e e TR T

Miniatyrvy for bilder

En Miniatyrvy for bilder visas i vanstra sidan av fonstret om du har fler &n en sida. Har
kan du véxla mellan sidor och &ven ta bort sidor. Den visar ocksa status pa sidan - se
Korrekturlas.

Huvudomradet
Huvudomradet i mitten av fonstret visar varje sida och vad som kommer att bli skannat

(OCR) pa varje sida. Dessa kallas for Zoner. Textzoner och bilder som blir skannade &r
markta med rutor och ikoner:



IEITextzon som ska bli skannad: Text i en textzon kommer att OCR behandlas och bli
lasbar och klar for att redigeras.

IEIBiId som ska bli skannad: All text i en bildzon kommer inte att bli lasbar for den blir
inte OCR behandlad. Texten visas exakt som i originaldokumentet.

Du kan redigera dessa zoner for att kunna kontrollera vad om skannas och OCR
behandlas. Se Valj vad som ska skannas.

Verktygsraden for forhandsgranskning

Till vénster om férhandsgranskningen finns det en verktygrad med méanga val:
[\ﬁ Valj zoner med musen

B3 Ta bort den markerade zonen. Markera omr8den som inneh3ller skanningsfel
(markerat pa originalpappret) och onddig text. Klicka pd Ta bort fér att de inte ska
komma med i ditt slutresultat.

@Skapa en textzon. Endast text i en textzon kommer att bli skannat och visas i ditt
slutresultat.

@Skapa en bild. Endast bilder i en bildzon kommer att bli skannat och visas i ditt
slutresultat.

Skapa en tabell.

Tar bort delar i en zon. Anvands for att skapa oregelbundna textzoner runt text som
inte finns i en enkel rektangel.

o
Ta bort alla zoner pa denna sida. Anvandbar genvdg om du manuellt vill rita om dem.

Faff ..
el Andra lasordningen i slutresultatet. Anvandbart om du vill spara till PDF. Se Bestam
[asordningen.

W% Zooma in férhandsgranskningen.

“%Zooma ut férhandsgranskningen.

LS
EZooma sa att hela nuvarande sida passar i fonstret. Du kan maximera fonstret for att
gobra det storre eller zooma in for att se ett stycke mer i detalj.

@Angra.

der om.



Vénd bilden vertikalt (sa vanster gar till héger och héger till vanster).
L Rotera sidan moturs.

Rotera sidan medurs.

13 Rotera sidan 180 grader. Anvandbart om din skanner presenterar sidan upp och ner
och ClaroRead inte har klarat av att vdnda pa den.

E‘Skriv ut alla skannade sidor. Detta kan vara anvandbart om du vill kopiera sidor:
skanna och skriv ut utan att géra nagot.



Valj vad som ska skannas.

ClaroRead gér sitt basta for att allt pa sida ska bli begripligt och kan da ibland férséka
att skanna stycken som du inte vill som markeringar pa en sida eller bilder som du inte
vill ha med i slutresultatet.

Omraden som ska skannas kallas fér zoner. Du kan lagga till och ta bort zoner genom
att anvanda knapparna pa Verktygsraden for forhandsgranskning.

Exempel pa redigeringszoner

ClaroRead har identifierat en pratbubbla om en bildzon s& det kommer att komma med
dokumentet efter skanningen. Vi vill hellre ha den som en textzon istéllet sa den kan bli
upplast. Vi bryr oss inte om att vi inte far med oss bilden.

F - - 2
% ClarcRead Pro Preview Elﬂu

Klicka p& bildzonen for att markera den:
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Klicka pa Ta bort zon for att ta bort den. Den kommer nu inte med i slutresultatet:
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=

Send to Ward

Klicka p& Skapa en textzon, vélj sedan omradet som du vill skanna och OCR behandla.
Denna text ("Fixa hjalp nu!") kommer att visas om lasbar text i slutresultatet:
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Bestam ldsordningen

lE:Léisordningen ar mycket viktig om du goér PDF filer. Du kan bestamma den genom att
klicka p& knappen zonordning och sen klicka p& varje zon (bild eller stycke av text) i
forhandsgranskningnen. En pil och ett nummer visar den slutgiltiga ordningen.

’
# CiaroRead Pro Farhandsgranskning = B
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Ta bort sidor frdn ett inkommande dokument

Du kan ta bort sidor fran ett inkommande dokument. Du kanske bara vill skanna ett
kapitel fran en PDF fil.

Detta gor du genom att markera sidor i miniatyrvyn for bilder pd den vénstra sidan. Den
visas endast om du har fler &n en sida fran det inkommande dokumentet. Du kan sen
valja Delete tangenten eller hégerklicka och vélja rensa for att ta bort markerade sidor.
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Korrekturlasning (endast ClaroRead Pro)

Med det valbara alternativet "Korrekturlas" i skanningen kan du kontrollera stavningen
och ratta eventuella fel programmet gér nar det konverterar original dokumentet till text
(OCR behandling). Detta gor att upplasningen blir korrekt. Du kan redigera dokumentet
men om du vill géra stora andringar rekommenderar vi att du sparar dokumentet som
ett Word dokument och redigerar det i Word.

Du kan aktivera korrekturlasningen genom att markera "Korrekturlas fére konvertering

till text" pa fliken Skanna i installningarna. Skanna sedan som vanligt fr&n papper eller

PDF/fil. Efter forhandsgranskningen kommer dialogen for korrekturlasning att visas foljt
av felstavningsfonstret:

-
# ClaroRead Pro Korrekturl3sning &lﬂﬁ‘

Arkiv Redigera Visa Formatera Verktyg

- = E3| 'E
Véalkommen till ClaroRead ||.......|
g -
Spara s0m..,
| @

Valkommen till ClaroRead. ar skapat&rg;ttgﬁ;gdet enklare for dig
med din dator genom att fa den att tala och gora det enklare att Jasa. De

integrerat med Microsoft" Word@ for att st9dja dig nar du jobbar med din

hjalper dig aven med wehhsider och e-post samt mycket annat du kan vilja
din dator.

ClareRead tillfor kraftfulla talfunktioner som later dig lyssna pa all informati
visaspa din datorskarm. Den kommer aven med flera enkla satt att gora text 1

ochlattare att lasa. Vi har aven inkluderat anvandhara rattstavningsyerkty
hjalpadig skapa korrekta dokument.

m | ’
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Med stavningskontrollen i korrekturlds kan du foérflytta dig mellan felen i dokumentet. Du
kan stanga detta nar du vill och starta det igen fran verktygsmenyn. Se Korrekturlas.

I mitten av fénstret finns ordbehandlaren. Denna visar upptackta fel med réd
understruken linje precis som i Microsoft Word. Du kan anvanda detta for att ratta till
felstavningar och igenké&nningsfel i ditt dokument. Sidan visas alltid i original formatet sa
du kan enkelt jamféra texten med originalet. Dina val av att behalla original formatet
eller att férenkla formatet kommer att bibehallas i slutresultatet.

Ovanfor ordbehandlaren finns Kontrollfunktionen. Den visar den aktuella originalbilden
som du har skannat och den féljer din markér i ordbehandlaren. P& sd satt kan du
kontrollera skanningsresultatet (i ordbehandlaren) med originalbilden (i fénstret
kontrollfunktionen)

Till vanster finns Miniatyrvyn for bilder dar alla sidor visas ifran det inskannade
dokumentet.

Anvand ordbehandlaren och kontrollfunktionen for att ratta eventuella fel i ditt
dokument, klicka sen pa ndgon av knapparna till héger for att skicka till Word eller spara
till fil nar du ar klar med din korrekturlasning.

Miniatyrvy for bilder

Miniatyrvyn for bilder visar alla sidor som kan korrekturldsas. Klicka pa en sida for att
vélja den. Miniatyrvyn visas inte om du bara har en sida. Vyn visas ocksa i fonstret for
Férhandsgranskningen.

“®Den nuvarande valda sidan.

Bredvid denna finns en ikon som visar status pa sidan:



"En sida som &nnu inte har blivit OCR behandlad. Du ser detta pa alla sidor i fonstret
for Férhandsgranskning.

F4En sida som har blivit OCR behandlad men inte dndrad pa nagot annat satt.

k%En sida som har blivit korrekturlast i denna dialog.
JEN sida som du har gjort éandringar i.

¥iEn sida som du har korrekturlast och gjort andringar i.

Du kan ta bort en sida genom att markera den och valja Delete tangenten (eller
hogerklicka och vélja Rensa fran menyn.

Statusfaltet, linjal och verktygsfalt
Du kan aktivera eller avaktivera dessa i menyn Visa. Som standard ar alla avaktiverade.

Verktygsfiltet Formatera innehaller knappar for stil, Teckensnitt, Rattning, Punkter och
Numrering och Stycke, precis som i Word eller WordPad. Dessa kan anvandas for att
redigera text i korrekturldsningsfonstret sa att du kan fa en uppfattning om hur
slutresultatet kommer att se ut.

Verktygsfaltet Markera for borttagning har knappar for Markering och genomstrykning
som du kan anvanda fér att marka upp ditt dokument. Den har ocksa ett verktyg som du
kan anvanda for att markera delar av texten som du vill ska visas med svarta rektanglar
dver texten (sd att du kan se dar texten var). Markera med verktyget och klicka p& den
sista dokumentknappen for att ta bort den markerade texten.

Linjalen ger dig storleken pa dokumentet eller pa textomradet. Du kan dndra mellan
tum, centimeter, punkter och picas i menyvalet Visa och dess undermeny "Mattenheter".

Statusfaltet visar markdrens position och vilket sprak som ClaroRead tror att du
anvander for att skriva texten. Detta &r anvandbart ifall spraket inte stimmer éverens
med som verkligen anvénds. Om inte sa blir texten inte igenkédnd pa ett korrekt satt.
Anviand valet Valj sprak... i menyn Verktyg for att &ndra valt sprak.

Visa
Du kan se aktuell sida pa tre olika satt. Detta valjer du fran Visa > Ordbehandlarvy.

Med "Originalsida" menas att den kommer att se ut som det gor pa originalpappret.
Detta &r anvandbart for att identifiera Iasordningen och fa en bra struktur pa sidan.
Detta ar standard nar man startar.

Formaterad text drar ut textinnehdllet men bibehaller teckensnitt, firg och storlek sa det
blir som att redigera ett Word dokument. Detta kanske ar enklare men visar
slutresultatet battre om du OCR behandlar en PDF fil pa nytt.

Oformaterad text visar endast textinnehallet. Detta &r bast om du endast vill arbeta med
textinnehallet, till exempel om du konverterar text till ljudfil.

Kontrollifunktionen



I korrekturlasningen arbetar du med vad ClaroRead tror ar det underliggande
textinnehallet. Om du skannar fran papper eller en fil kan detta bli fel - till exempel, du
kanske har ett omrade pa papperet som férvirrar. Det kan vara svart att ratta i
korrekturlasningen om du inte ser originalet.

Kontrollfunktionen ger dig en del av den underliggande filen eller papperet som
ClaroRead arbetar pa. Detta ger dig mojlighet att kontrollera texten som du har i
ordbehandlaren och som du sen kan jamféra med originalsidan. Aktivera den i Visa >
kontrollfunktion och valj Visa. Klicka varsomhelst i texten. Kontrollfunktionen visar nu
den del i originalsidan som motsvarar din placering i ordbehandlaren. Nu kan du
kontrollera att de stammer 6verens. Du kan zooma in och ut for att kontrollera mindre
detaljer med alternativet Zooma.

Som standard visas kontrollfunktionen ovanfér ordbehandlaren. For att gora den flytande
(félja markdren) valjer du Dynamisk. For att andra vad som visas i den flytande
kontrollfunktionen valjer du Linje, Tre ord eller Ett ord fran kontrollfunktionens
undermeny.

Teckenuppsattning

Du kanske har icke-standard pa din teckenuppséattning i ditt sprak i din text. Till
exempel, i en textbok for matematik finns det ofta Grekiska tecken som sigma () eller
pi (). Detta kan forvirra ClaroRead (om det ar skanning av Svenska kommer ClaroRead
forsdka gora svenska tecken) och producera ett felaktigt resultat. Du kan I6sa detta och
forbattra skanningen genom att lagga till dessa tecknen till en teckenuppsattning som
kanns igen. Visa en teckenuppsattning du vill anvanda genom att valja den i Visa >
Teckenuppsattnlngar > Teckenuppsattmng Klicka pa tecknet du vill l4gga till. Detta blir
sparat sa du behéver bara géra det en gang.

Du kan ocksa vélja "Redigera tilldtna tecken" i verktygsmenyn och lagga till ett tecken
for hand.

Trana teckenigenkdanning

Du kanske vill ratta vissa stycken som inte har blivit igenkadnda pa ett korrekt satt, som
Grekiska bokstaver som anvands i en matematikbok eller frén ett inskannat papper.
Dessa tecknen eller stycken blir markerade med gult i ordbehandlaren. Klicka pa tecknet
for att placera markdren pa det. Valj sedan "Trana teckenigenkénning" fran
verktygsmenyn. Fonster for "Tréana tecken" 6ppnas igen och visar original texten/filen
och vad ClaroRead tror att det ar. Skriv i korrekt tecken i rutan "Ratta" och klicka Trana
for att ratta den skannade texten. Dessa rattningar blir ihdgkomna till nasta gang.

Du kan granska teckentraningen genom att vélja "Redigera teckentraningen" fran
verktygsmenyn. Valj och ta bort den tréaningen du inte vill spara eller hdgerklicka och
redigera den.

Du kanske maste tréna ett antal tecken, till exempel dar ClaroRead har identifierat ett
enda tecken som ett antal tecken. Valj helt enkelt alla berérda tecken innan du klickar
pa "Tréna teckenigenk&nning" sa blir tréningen och réttningen tillagd fér att tecken ska
uppfattas pa korrekt satt.

Formatera

Du kan redigera texten i dialogen fér korrekturlasning. I Formatera menyn kan du andra
bl.a teckensnitt, stycken och stil. Detta ar anvandbart ifall du planerar att spara



dokumentet som en PDF fil och vill andra hur det ser ut, till exempel dndra till annat
teckensnitt &n i original dokumentet. Tank pa att om du vill &ndra i dokumentet kan det
vara battre att skicka det till Word for att géra det dar.

Observera att om du sparar som PDF kommer den ursprungliga positionen och storleken
for textomradet finnas kvar. S& om du gor texten stérre kommer den att éverlappa och
delar kommer att saknas. Om du vill redigera dokumentet du skannat in rekommenderar
vi att du skickar det till Microsoft Word for att redigera och ratta det istdllet for att
anvanda dialogen for korrekturlasning.

Korrekturldsning

Precis som i Microsoft Word kommer dialogen 1ata dig ga igenom alla identifierade
stavningsfel eller igenkanningsfel i det aktuella dokumentet. Detta startas automatiskt
nar du dppnar dialogen fér korrekturldsning. Du kan ocksa vélja Korrekturlds fran
verktygsmenyn sa startar processen igen. Nésta stavnings eller OCR problem visas och
du kan bestdmma om du vill rétta det eller Idgga till det precis som i Word. Andringar
kommer att bli ihdgkommna i framtida skanningar. N&r du &r fardig med en sida eller ett
dokument, Klicka pa "Sida fardig" eller "dokument fardigt" sa identifieras inga fler fel pa
denna sida. Nar det inte finns fler fel i dokumentet blir alternativet for
korrekturldsningen gramarkerat.

Du kan ocksa vélja F4 eller vélja "So6k nasta missténkta" for att hoppa till nésta
identifierade fel utan att 6ppna korrekturlasningen. Om du vill starta processen igen och
fa foregdende markerade sidorna eller hela dokumentet markta som fardiga, valj da
kontrollera igen fran verktygsmenyn.

Du kan granska stavningen du har lagt till i ordlistan genom att valja "Redigera ordlista"
fran verktygsmenyn. Detta visar en lista pa orden som kdnns igen med korrekt
stavningen. Du kan ta bort ord som inte boér finnas dar och borde vara markta som
felstavade.

Crrdiista @

Ord |

Ok |

X Ta bort ord

= — —r

Sprak

Det &r viktigt att ClaroRead har rétt sprak i dokumentet. Om det inte stdmmer kommer
texten inte att kdnnas igen nar den OCR behandlas och orden blir tolkade som



felstavade. Statusfaltet visar spraket pa den aktuella texten. Du kan markera text och
identifiera korrekt sprak genom att vélja sprak fran verktygsmenyn.

i B
Sorik |2 i

Markera vald text som:

Slovakiska -
Slovenska

Somali

Sorbiska

Sotho =
Spanska & |
Sudanesiska sprak

Gora PDF filer tillgangliga

PDF filer ar vanliga men kan vara svara att anvédnda. ClaroRead Pro och Plus ger dig en
madjlighet att géra dem anvandbara och tillgangliga.

Detta ar en guide for hur man gor tillgangliga PDF filer med ClaroRead. For en
fordjupning om tillganglighet av PDF filer, se PDF och tillgénglighet.

Snabbinstadllning

Detta &r fér anvdndare som vill géra PDF filer fér eget bruk fr8n inskannade bécker eller
dokument eller de som har en PDF fil som de vill ha uppldst men som &r otillgénglig
(laser inte alls eller ldser inte s§ bra). Detta fungerar i ClaroRead Plus (versions 5.7 eller
senare) eller ClaroRead Pro.

e 1. Skanna med Plus eller Pro.

e 2. Klicka pa Spara som och spara som en "ClaroRead PDF" fil. Denna blir automatiskt
tillganglig genom ClaroRead.

e 3. Las upp PDF filen genom att 6ppna den med Adobe Reader och Las den med
ClaroRead.

e 4. Spara PDF-fil for framtida referens — mycket snabbare @n att skanna den igen.

Du kan alltid skanna filen igen med ClaroRead Plus eller Pro om du vill andra dess
tillganglighet, format eller konvertera den till Microsoft Word for att redigera den.

ClaroReads skanningsprocess ar optimerad for att gora en tillganglig PDF fil. I vissa fall
kan du fa en PDF fil upplast ganska bra med med vissa problem. Det kan fungera béttre
ifall du skannar den och sparar den som en PDF fil igen.

Avancerad instdllning



Detta &r anvéndbart fér den som vill skapa en tillgénglig PDF fil med hég kvalité, kanske
fér omférdelning eller I8ngtidslagring. Det fungerar med ClaroRead Pro men du kanske
méste rétta till Idsordningen i fénstret Férhandsgranskning om du anvénder ClaroRead
Plus.

Bestam din malgrupp. Delningen &r "skarmlédsare och andra personer med mycket
nedsatt syn" och "Musanvéandare och ménniskor med ldssvarigheter" eller "blind" och
"dyslektiker" fér att géra det enkelt. Se PDF och tillgédnglighet fér en férdjupning pa
skillnaderna.

Bestam dig for hur mycket arbete du vill ldgga ner pa innehallet i dokumentet. Gor du i
huvudsak den befintliga filen tillganglig (till exempel fér en dyslektiker) eller gor lagger
du ner mer arbete fér att géra om innehallet mer fundamentalt?

Instédllningar for ClaroRead Pro

a. Aktivera Forhandsgranska och (valfritt) Korrekturlasning i Installningar fér ClaroRead
Pro pa fliken Skanna.

b. Va&lj ratt OCR sprak i Installningar for ClaroRead Pro pa fliken Skanna.

c. For "blinda" anvandare, dvervag att avaktivera bilder och att férenkla formatet. For
"dyslektiker" aktivera bilder och anvand original formatet.

Skanna fran papper eller fil med ClaroRead Pro.

ClaroRead Pro férséker upptédcka den ratta ldsordningen i dokumentet och ta bort
onddiga bilder.

Ratta till [asordningen i Férhandsgranskningsfonstret.

a. Ta bort éverflédigt innehdll fér "blinda"anvéndare, t.ex. sidhuvuden och sidfétter.
b. Ta bort sidnummer och annat icke lasbart innehall for "dyslektiker".

ClaroRead OCR behandlar och konverterar all otillgéngligt innehll till tillgénglig text.
Ratta textinnehallet i fonstret fér Korrekturldsning.

a. Rétta felstavning och igenkanningsfel fran OCR behandlingen.

b. Lagg till fullt stop vid slutet av titlar och andra linjer utan skiljetecken.

Resultat i 6nskat format.

a. Om du behdver goéra stora é@ndringar i dokumentet ar det battre att du skickar det till
Word. Word ar mycket battre att anvanda for redigering éan ClaroRead. Om du har Word
2010 kan du spara Word dokumentet som en PDF fil direkt. Se till att den ar taggad
(Spara som, PDF, Alternativ, kontrollera "Dokument struktur taggar for tillganglighet").
Du kan ocksa lagga till innehall och rubriker i Word 2010.

b. Om du &r n6jd med innehallet som det &r sparar du dokumentet som en fil. Var saker
pa att det &r PDF version 1.4 eller senare.



1. Om du vill att resultatet ska se ut precis som originalet sparar du det som en
ClaroRead PDF. Detta ar det enda séttet for att vara sidker pa att resultatet ser ut precis
som originalet som du har skannat, vilket ar vardefullt for en "dyslektiker".

11. Om du vill att produktionen ska kunna aterstrémmas och zoomas och inte bryr dig
om att det maste se ut som originalet sparar du det som en vanlig PDF eller text fil.

For PDF resultat, information om tillgédnglighet — taggar — se har
Upplasning med ClaroRead (Adobe Reader, Microsoft Word, eller anvand Spara till ljud

eller Video) eller skicka ut den tillgangliga filen till andra. Férvara filen sdkert sa att du
inte behéver géra om hela processen igen.



Denna sida medféljer pa Engelska.

PDF and Accessibility

This is a guide to PDF, how it affects people trying to use assistive technology (A.T.) with
it, and what can be done. It assumes familiarity with A.T., whether a screenreader or
magnifier or reading toolbar like ClaroRead, and with Adobe Reader. It is designed for
organisations producing PDF files and for A.T. practitioners to better-understand the
issues. It may be of use to Adobe Reader users who want to understand how best to
approach PDFs.

Chapter 1 describes PDF, how it fits into business processes, and why it is popular. It
tells you how you can approach the production of accessible PDF files.

Chapter 2 describes the specific technical problems with PDF for the “traditional”
screenreader user, why it can be hard to use, and the solution (tags) that Adobe has
invented to help.

Chapter 3 describes how Adobe Reader handles a PDF and the implications for how a
PDF should be structured.

Chapter 4 catalogues the visual display options for Adobe Reader and how they interact
with the accessibility features.

Chapter 5 provides a set of “best” settings for Adobe Reader or for accessible PDF files.

Chapter 1: The Adobe Portable Document Format
(PDF)

PDF does a great job for what it is designed to do: it describes what should be printed on
paper. It was invented so that people creating documents on the new desktop publishing
technology in the 1980s and 1990s could send them to printers and have them appear
as they intended - font, colours, layout.

So PDF works in terms of pages, and what images and text goes where on each page. It
has no idea of things like headings, or columns, or chapters, or words or sentences.

PDFs fit into traditional business print processes very well, and still does:

o Writers write text in a word processor (Microsoft Word, Pages, OpenOffice). Graphic
artists create images (Adobe Photoshop, Adobe Illustrator, Inkscape, GNU Image
Processor).

o Graphic designers and editors lay out the text and images in a desktop publishing
program to create the brochure or report or book (Adobe InDesign, Microsoft Publisher,
Quark Express, Scribus).

o The ready-to-print document is exported from the desktop publishing program as a
PDF file and sent to managers and stakeholders to review. Minor corrections are made
and the final PDF sent a commercial printer. Because PDF cares about font, and colour,
and layout, the editor can be confident that the printed document will look just as they
intended.



The problems arose when people started trying to use PDFs not for print but for online
distribution and eBooks and other non-print purposes. There were and are good reasons
for this. The existing business processes had already produced millions of PDF files and
continued to produce new PDF files as the final, edited format, so it was no extra work.
PDF is an open format, so every platform has a PDF reader and they all display
documents the same - you can’t send a Microsoft Word document to someone on a
different platform and count on it looking the same. Adobe has always provided a free
reader, Adobe Reader, for most users. PDFs let you keep your publications in your
corporate font and colours and style, so your manager is happy. There is an incorrect
belief that PDF files cannot be edited or changed, so people are confident that their
documents will always present their intended message. And finally, PDF gives you a way
to collect images and text together in a single file, which gave it the edge over that other
ubiquitous format, HTML, when you want to email your report.

It is likely, then, that any organisation produces PDFs as their main form of content
production, second only perhaps to their website. Often the substantive content on the
website itself is in PDF - reports, brochures, newsletters.

But while PDF is convenient for creators and distributors of content, it is not for some
consumers of content, notably people who are not in a position to use Adobe Reader to
display PDF on a standard desktop system (or print the document!) and read the content
visually off the page. People who use assistive technologies like screenreaders and
magnifiers have considerable problems with PDF, described in more detail in Chapter 2.

What can be done?
There are two options: stop using PDF and make the PDFs you produce accessible.

For the reasons given above you are probably not in a position to stop producing PDFs.
You will still be delivering files to printers. You will still be doing your final editing and
approval in PDF. The final PDF file is your canonical document for distribution. You could
change your business process: for example, when the text for your documents are
created in a word processor, before it is laid out, it is in a format that makes sense for
assistive technology - big lumps of text. But that means duplicating effort in your
business process. The flow of content from writer and artist to final document has to be
performed twice, once with PDF as the intended output and once with an alternative
format in mind. This can be expensive. It could backfire if you choose the “wrong”
alternative format. And the extra delay to produce the alternative format is likely to be a
problem.

So you are probably going to want to keep creating PDF files, and make them accessible
after the fact. There are several ways of doing this.

o You can take just one step back, to the desktop publishing program that produced
the PDF, and use its ability to support accessible PDF output. For example, Adobe
InDesign lets you set reading order and created tagged documents when you output to
PDF. However, as noted above, this may not be just one step: it may be many steps.
This probably requires the most in-house investment in time and skills.

o You can use another application to take the PDF and make it accessible. They vary
in terms of cost, ease-of-use, and the ability to automate the process. This can be easy
or hard but is quite cost-effective depending on the tool.

o You can send your PDF files to an external agency, which will use one of the afore-
mentioned tools to make the PDF more accessible. This is the easiest but most



expensive option. Your printer may offer this service, although PDF accessibility is a
specialised field.

Whichever approach you take, if you are interested in the accessibility of your PDFs, the
rest of this document will help you understand the issues.

Chapter 2: The basics of PDF Accessibility — Tags

PDF is a format designed for printing and displaying on the screen, so it often does not
work well with speech and other assistive technologies.

These are the problems with PDF in the context of trying to use them with A.T.:

1. Images. It can have bitmap images in them - pictures of text, not text itself. This
means that the content cannot be read at all. This must be solved by OCR - optical
character recognition - turning the image into text.

2. Reading order. It does not know in which order things should be read - so it does
not understand that you read down columns, then to the top of the next column, for
example. This means that when you try to read a PDF it reads across columns, or jumps
about the page, or reads out of order.

3. Structure. It does not know anything about content, like "headings" or "lists" or
even "sentences" and "paragraphs" - so you can't skip to headings and when you try to
read by sentence the highlighting goes wrong. Not being able to skip around is okay for
sighted mouse users because they can see the headings and chapters and suchlike,
scroll around and click where they want to play. It's difficult for blind screenreader users,
who have no way to skip around the document and make sense of all the text. The lack
of "sentence" and "paragraph" structure can lead to odd reading for everybody, like
sentences being split in the wrong place or highlighting not matching the sentence being
read. (In formal terms this is referred to as “semantics” — PDF files do not have any
semantic information.)

4. Zoom. It does not reflow well. That is, if you are reading text on a mobile 'phone,
or zooming in because your vision is poor, it is hard to read a page if you have to scroll
left and right to see the whole of every line. It is much easier if the page reflows -
rearranges to cope with the larger text size - and you still only have to scroll up and
down.

To solve Problem 1 (images) you have to do OCR - there is no way round that. But even
if all the text in your PDF file is text, not images of text, you still have Problems 2, 3 and
4 (reading order, structure, zoom)

To solve these problems Adobe added features called tags. These tell Adobe Reader
what order should be used for the text and provides chapters, headings and other styles.
So a tagged document is much more accessible for reading. To be exact, a document
must have tags to be read. These tags provide the information to allow reading order,
structure and zooming to work.

However, most documents are not tagged. Adobe Reader will therefore attempt to work
out tags when it opens these documents. This has two problems: first, it can take a long
time. That dialogue that comes up when you open a PDF file, "Preparing document for
reading" - that is Reader working out the tags. A hundred-page PDF file, which is really
quite common, can take a few minutes on a fast machine, which is very off-putting if you
just want to quickly check out a document. Second, it may not be very accurate.



Columns, textboxes, and captions can all confuse Reader when it tries to create a
reading order. No attempt at structure is made. Reflowing the PDF file may not work
well. Finally, the tags worked out by Reader are not stored anywhere for future use, so if
you close and open the PDF again then the same process must be followed.

It is clearly much better to define the tags beforehand, rather than leaving it to Adobe
Reader. In fact, this is essentially what is meant by “creating an accessible PDF” - it
means “adding correct document tags so reading order, structure and zooming are all
correct” (although OCR'’ing of images is required in some cases too, of course.)

(Note that Google takes account of reading order when it indexes PDF files it finds
online, which means that your PDF files will work better and produce better search
results if you take the time to set tags to identify the reading order!)

Other PDF features that affect Accessibility
Bookmarks

These can form a “contents” section, and are turned on in View, Show/Hide, Navigation
Panes, Bookmarks. (The option is not there if there are no bookmarks in the document.)
These are examples of structural (semantic) tags in the document. They are mainly of
use to screenreader users, who can use them to quickly skip around the document using
shortcut keys, and mouse users, who can easily explore the document tree and work out
where they want to read.

Fast Web View

Fast Web View enables PDF files displayed in a web browser to start displaying before
the whole file is loaded. The file is structured so that the first few pages can be displayed
as soon as they are received. This requires some re-ordering of the PDF file, but does
not necessarily have any impact on accessibility. However, some tools may, at the same
time as processing the PDF file so that it can support Fast Web View, discard all the tags
to "optimise" the PDF file, making it smaller and faster to download to view - but losing
all the accessibility information.

Punctuation

The punctuation of a PDF file affects how usable it is. A fully-tagged document correctly
identifies paragraphs and headings and other text structures, so assistive technology can
punctuation speech and output correctly - highlighting sentence by sentence for
example. In documents where tags are missing, or the document has been transformed
or lost its tags, Adobe Reader and other tools are better able to identify sentences if they
end with full stops. This mostly applies to headings, which generally do not have full
stops at the end of them. This can mean that Adobe Reader gets confused and runs the
heading into the next paragraph, which can be confusing to the user. Full stops help
your document read correctly no matter what happens to it.

Forms in Adobe Reader

Forms allow users to fill in textboxes and select buttons and checkboxes in the PDF
document, and even submit it to an online service. For accessibility the form elements
should be tagged to indicate their name and function, and their order should be specified
for clarity and to enable tabbing around the form in a sensible order.



If you do not provide tags for forms then Reader will try to infer the tab order from the
document structure. If "Use document structure for tab order when no explicit tab order
is provided" is unchecked then Reader will go across the page and down, or down the
page and across, or some other order specified in the PDF file.

Adobe PDF files in web browsers

By default Adobe Reader makes PDF files appear within web browsers. This is generally
less accessible, since you don't have the menu, and the space given over to the display
of the PDF must be smaller, and many access programs will not work with the PDF when
it is within the browser. This is especially the case for browsers other than Internet
Explorer.

You can make Adobe Reader launch PDF files encountered by your web browser by
unchecking Preferences, Internet, Web Browser Options, Display PDF in browser. This
means Adobe Reader will pop up when you open a PDF, which may be more confusing,
but is simpler.

Adobe Reader Multimedia options

The Multimedia tab of Preferences has an Accessibility Options section. These apply to
embedded video content and provide options for subtitles and other features.

Chapter 3: How Adobe Reader handles Accessibility

This chapter explains how Adobe Reader handles PDF accessibility. This lets you
understand how accessible a given PDF is, in the context of someone requiring text
access through a screenreader or other A.T..

(It is assumed you are using Adobe Reader on Windows. Mac users can employ
VoiceOver and the native PDF display tools on their Apple machine.)

Note that Adobe Reader does nothing for embedded images - it has no built-in OCR
feature. So these will always remain inaccessible (for anyone requiring text access, that
is).

First, Reader sees if there is a "screenreader" running. This means a program that has
told Windows that it needs special access to content so it can read it out, so programs
like ClaroRead count as well as JAWS and WindowEyes. If there is no screenreader
running, it just displays the PDF and nothing more is done.

Second, it checks the PDF file for any text that is not tagged. This doesn't include text
that is stored as pictures of text. And it doesn't matter if any of the text is tagged: so
long as there is any text that is not tagged then the document must be processed to
create tags. So a completely-tagged document can become "untagged" if one person
edits the PDF file in Acrobat and adds one caption or textbox. If a PDF file is completely
tagged then nothing more is done.

Third, it processes the PDF file and adds tags for PDF files where this is needed -
documents containing any untagged text. This is when you see one of these dialogues:
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Again, you will or you do not have a "screenreader" running.

You can check whether a document is tagged by opening it in Adobe Reader and going to
File, Properties. The Document Properties window shows if the PDF is tagged under
"Tagged PDF":
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Fourth, it takes the tags, generated or originally in the document, and works out the
reading order (technically it build the document object model.) Even for documents that
started off fully tagged this can take a long time. Also, you don't necessarily see any
progress dialogue if the document was tagged: Adobe Reader may stop responding while
it is working, but there is no other sign. You can't get it to read, of course.

Note that while by default Adobe Reader uses a reading order if one was already defined,
the user can change this. If "Reading Order" is set to "Tagged reading order" then the
pre-defined reading order is used. But if "Reading Order" is set to "Infer reading order
from document" then the reading order worked out by Adobe Reader will be used.
However, these two options are only visible where you have opened a tagged PDF file.
When Adobe Reader opens an untagged PDF file (where it has to work out the tags
itself) it hides the "Tagged reading order" option from the four "Reading Order" options
and defaults instead to "Infer reading order from document". You have to open a tagged




document to check that "Tagged reading order" is indeed the default for tagged
documents.

When the document has been fully-tagged then it is ready to be read aloud. Reading
order is fully-determined. Structure (semantics), like sentences and paragraphs and
headings, has been identified, and bookmarks identified. If the document is to be
zoomed it can be reflowed in a sensible pattern (see Chapter 4).

However, there are a number of complications.

o Because processing the document is so slow, Adobe Reader by default only
completely processes documents if they are shorter than 50 pages. If they are longer
than this then only the current page is processed. Only when you scroll or read past the
processed area is processing triggered again. You cannot read, again, until this is
completed. If your reading program cannot get to the next page itself when it finishes
reading the current page you have to intervene manually, switch to the next page and
start reading again.

o There are actually three options for reading order, found in Adobe Reader
Preferences, Reading, Reading Order Options, Reading Order. We have been describing
the default, "Infer reading order from document (recommended)". This means the tags,
whether generated by Adobe Reader or already in the document are used to work out
the order. A second option, "Left-to-right, top-to-bottom reading order" means that
Adobe Reader works out the reading order according to the layout of text on the page,
as described. This may work better in some pages, but may go completely wrong, for
example with columns. Finally, the third option, "Use reading order in raw print stream”,
does not look at the layout of the text on the page at all, but the order of text inside the
PDF file. This can actually be better for some documents than Adobe Reader's attempt to
work out the reading order, but can be completely wrong for other documents - whole
paragraphs can be out of order, for example.

o Even if a document is fully tagged then it is possible to ignore this provided order -
Reading Order Options, Override the reading order in tagged documents. We can
assume that someone has set this for a reason: it should be unset to provide a good
experience with a correct accessible PDF.

At a technical level, the external interfaces used by A.T. programs, like the Microsoft
Active Accessibility (MSAA) interface, and the Adobe Reader Document Object Model
(DOM) are now generated and available for use. Again, these all depend on the tags of
the document.

For non-mouse users without sight, this is generally the point where their A.T. takes
over. For example, JAWS screenreader users do not care about the zoom level of the
PDF they may not be able to see at all. Other users may employ the built-in Adobe
Reader Read Out Loud function, which reads the text using synthesised speech but
otherwise does not change the display of the PDF. For users with some sight, many
other Adobe Reader and PDF features come into play, described in the next chapter.

Chapter 4: How Adobe Reader handles PDFs for a
sighted user
This chapter describes key Adobe Reader features for people with some sight who need

zooming, or high-contrast, or low-contrast, or other visual features to make a PDF easier
to use.



Traditional accessibility concerns are often about blind screenreader users. But some
people simply want the text scaled up a bit (zoomed in) or the colours set to something
that is comfortable to read, such as a high-contrast setting for people with poor vision or
a low-contrast setting for people with some print impairments like dyslexia.

Setting the colours to something that is suitable is quite simple. Preferences,
Accessibility, check Replace Document Colours. This overrides the colours in the original
PDF files with a choice of the Windows Colour Scheme (for example, if you have selected
the High Contrast yellow-on-black Windows scheme), one of four High-Contrast
combinations provided by Reader, or a completely Custom Colour combination for text
and background. The custom option may be useful if you want a lower-contrast colour
combination, for example if you have dyslexia.

The problem with zooming in a PDF is that it designed around fixed pages, so when you
zoom in you have to start scrolling left and right to read whole lines across the PDF, just
like using a magnifying glass on a real piece of paper:
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This does not only affect people with visual impairments. It also affects people trying to
read PDF files on small devices, like mobile 'phones. The solution is to make PDF files
more like web pages, so when you zoom in the text rewraps or reflows, making new
shorter lines, so it fits across the width of the available display area and you do not have
to scroll left and right:
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Images are centred and scale to fit too. One drawback is that you cannot do a text
search in Reflow mode. You can switch to this view with Ctrl+4 at any time, or select
Reflow from the Zoom submenu of the View menu.

This ability to reflow depends on the content of the PDF being text, not images before
OCR, and the tags in the document. Also, some types of PDF file will not reflow: PDF files
with images and text behind them cannot reflow, because the text is locked to the
position of the image. This is important because these PDF files, often called "searchable
PDF" files, are very popular since they allow a scanned page from a book to be perfectly
captured in a PDF with text behind them so you can read it aloud. This is great for, for
example, dyslexic students who can refer to the original textbook and use the mouse to
decide what to read where on a desktop computer. It is not the right format for people
with a visual impairment who want to scale the text or people reading PDF files on a
small mobile device.

Finally, when a document is Reflowed, Adobe Reader does not update the accessibility
information available to external applications, so you will have to close and open the PDF
file to work with it in this new format.

Zoom, Page Display and Reflow settings in Adobe Reader

By default PDF files tell Adobe Reader how they should be zoomed and displayed when
they are opened. You can change this when they are opened with shortcut keys, menu
items, or the toolbar. But you can also change Adobe Reader to display all PDF files in
your preferred format permanently.

Note that if the setting Preferences, Documents, Open Settings, "Restore last view
settings when reopening documents" is checked then you will not see your changes to

the defaults have an effect for PDF files you have already opened. Uncheck this before
you try experimenting with the default display options.

Page Display

There are three default settings for Page Display:



e That set in Preferences, Page Display, Default Layout and Zoom, Page Layout.

e That specified by the PDF file itself. This overrides the setting in Preferences, Page
Display.

e That set in Preferences, Accessibility, Override Page Display, Always use Page Layout
Style. This overrides the other two settings if you check Always use Page Layout Style.

So you need to set your preferred Page Display in Preferences, Accessibility if you want
it respected. "Single Page Continuous" is probably best for seeing most of the document
at a decent size. The complete set of options in Preferences, Accessibility are:

Single Page

Only one page is shown. If it is zoomed in, then you may have to scroll around, but
when you scroll to the edge of a page it "flips" to the next page.

Same as menu item View > Page Display > Single Page View

Single Page Continuous

One page width, you can scroll up and down and see each page on top of each other.
Same as menu item View > Page Display > Enable Scrolling

Two-up

Two pages shown at once. If they are zoomed in, then you may have to scroll around,
but when you scroll to the edge of a couple of pages it 'flips' to the next two pages.

Same as menu item View > Page Display > Two Page View
Two-up continuous

Two pages wide, you can scroll up and down and see each two pages on top of each
other.

Same as menu item View > Page Display > Two Page Scrolling
Zoom

You can set the default Zoom by going to Preferences, Page Display, Default Layout and
Zoom, and setting Zoom to your preferred setting. You can also set the default Zoom by
going to Preferences, Accessibility, Override Page Display, Always use Zoom Setting.
These have slightly different options. The Accessibility Zoom setting will override the
Page Display setting. Both will override the PDF file setting.

"Fit visible" (Page Display) or "Fit width" are good if you have a small display and limited
sight, and "Fit page" is good if you have a big display (so you don't have any zooming or
scrolling) or you have no sight (so you don't care what size it is but it simpler to
understand what page you are on.)



"Reflow" (Accessibility) is good if want to zoom in a document but don't want to have to
handle horizontal scrolling. Some pages reflow better than others: tagged accessible PDF
files reflow best.

The complete set of options are:
Automatic (Page Display only)

The PDF file is allowed to specify how it should be zoomed. This is the default. It usually
means 'display the whole page, zoomed out to fit'.

Fit Page

The document is zoomed so that exactly one page fits horizontally or vertically in Adobe
Reader, whichever is smaller. If "Single Page" is selected as the Page Display then only
one page will be visible, but all of it will be visible. If "Single Page Continuous" is

selected as the Page Display then you can see more than one page, but the pages will
still be zoomed as though only one is being fitted to.

Fit Width

The document is zoomed so that the width of the whole page fits across the whole of
Adobe Reader. This means you don't have to scroll left or right, which can cause
confusion, but can mean that you have to scroll up and down to read a whole page.

Fit Height

The document is zoomed so that the height of the whole page fits vertically the whole of
Adobe Reader. This means you don't have to scroll up or down, but since most
documents are portrait orientation, the PDF will appear very small.

Fit Visible (Page Display only)

PDF documents normally have blank borders, suitable for printing. "Fit Visible" means
the borders are not displayed, so the page content (text, images) can take up more of
the Adobe Reader display and therefore be a little larger.

Reflow (Accessibility only)

Every document is reflowed.

10% - 6400%

Zoom by a fixed ratio.

Colour in Adobe Reader

The Accessibility section of Preferences has a Document Colors Options section that
allows you to set the desired colour of text and background colour. You can select from
the Windows selection, a pre-defined high-contrast palette and a custom palette.

One of the problems, though, is that embedded images and other complex drawing

elements like textboxes may not change colour “cleanly” — they may develop odd
shapes, or disappear entirely. So by default “"Only change the color of black text or line



art” is checked, meaning that sections of many documents will not recolour but
everything should still be visible. A further checkbox, "Change the color of line art as
well as text” lets you decide if graphics should be recoloured - again, for anything but
plain text, this may create visual confusion.

Chapter 5: Suggested “best” settings for Adobe
Reader

Clearly, it is necessary to get the Adobe Reader settings right to maximise the chance of
any PDF reading correctly. Here is the best set for best performance (at the expense of
slower loading time for large documents). It doesn't take into account the many settings
for multimedia and colour. It’s primarily to ensure that external A.T. applications have
the best access to the PDF file and have the best chance of working well.

Preferences, Reading, Reading Order

Set to "Infer reading order from document (recommended)".

Preferences, Reading, Override the reading order in tagged documents.
Uncheck this checkbox.

Preferences, Reading, Screen Reader Options, Page vs Document

Set to "Read the entire document".

Preferences, Reading, Screen Reader Options, Confirm before tagging documents
Uncheck this checkbox.

Preferences, Accessibility, Override page display, Always use Page Layout Style.
Check this checkbox. Set to "Single Page Continuous".

Preferences, Accessibility, Override page display, Always use Zoom Setting.
Check this checkbox. Set to "Single Page Continuous".

Preferences, Accessibility, Tab Order, Use document structure for tab order when no
explicit tab order is specified.

Check this checkbox.
Preferences, Internet, Web Browser Options, Display PDF in browser

Uncheck this if you want PDF files to open in Adobe Reader directly. This lets you see
more document content and works better with assistive technology.

Detta &r hamtat fran Adobe Reader X hjédlp manual (sidan 232-248) som &r pa Engelska.
Darfoér ar det inte dversatt till Svenska.



Chapter 10: Accessibility, tags, and reflow

Accessibility features assist people with disabilities, such as mobility impairments,
blindness, and low vision in their use of Adobe Acrobat X Standard and Adobe PDFs.

Contents
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Accessibility features

About accessibility features

A document or application is accessible if it can be used by people with disabilities, such
as mobility impairments, blindness, and low vision. Accessibility features in Adobe
Acrobat, Adobe Reader, and Adobe Portable Document Format (PDF) enable people with
disabilities to use PDF documents, with or without screen readers, screen magnifiers,
and braille printers.

Making PDFs accessible tends to benefit all users. For example, the document structure
that enables a screen reader to read a PDF out loud also enables a mobile device to
reflow and display the document on a small screen. Similarly, the preset tab order of an
accessible PDF form helps all users, not just users with mobility impairments, fill the
form more easily.

Accessibility features in Acrobat and Reader fall into two broad categories: features to
make the reading of PDF documents more accessible and features to create accessible
PDF documents. To create accessible PDF documents, use Acrobat, not Reader.

Features for accessible reading of PDFs

Preferences and commands to optimize output for assistive software and devices, such
as saving as accessible text for a braille printer

Preferences and commands to make navigation of PDFs more accessible, such as
automatic scrolling and opening PDFs to the last page read

Accessibility Setup Assistant for easy setting of most preferences related to accessibility



Keyboard alternates to mouse actions

Reflow capability to display PDF text in large type and to temporarily present a
multicolumn PDF in a single, easy-to-read column.

Read Out Loud text-to-speech conversion
Support for screen readers and screen magnifiers
For more information about accessibility features, see these online resources:

Acrobat 9 accessibility, overview, new features, and FAQ:
www.adobe.com/accessibility/products/acrobat/

Information and news about accessibility in Adobe products:
blogs.adobe.com/accessibility/pdf/

Creating accessible PDF documents: www.adobe.com/accessibility
General accessibility tips: acrobatusers.com/forums/aucbb/
About accessible PDFs

Accessible PDFs have the following characteristics.

Searchable text

A document that consists of scanned images of text is inherently inaccessible because
the content of the document is images, not searchable text. Assistive software cannot
read or extract the words, users cannot select or edit the text, and you cannot
manipulate the PDF for accessibility. Convert the scanned images of text to searchable
text using optical character recognition (OCR) before you can use other accessibility
features with the document.

Fonts that allow characters to be extracted to text

The fonts in an accessible PDF must contain enough information for Acrobat to extract all
of the characters to text for purposes other than displaying text on the screen. Acrobat
extracts characters to Unicode text when you read a PDF with a screen reader or the
Read Out Loud feature. Acrobat also extracts characters to Unicode when you save as
text for a braille printer. This extraction fails if Acrobat cannot determine how to map the
font to Unicode characters.

Reading order and document structure tags

To read a document's text and present it in a way that makes sense to the user, a
screen reader or other text-to-speech tool requires a structured document. Document
structure tags in a PDF define the reading order and identify headings, paragraphs,
sections, tables, and other page elements.

Interactive form fields

Some PDFs contain forms that a person is to fill out using a computer. To be accessible,
form fields must be interactive to let the user enter values into the form fields.



Navigational aids

Navigational aids in a PDF include links, bookmarks, headings, table of contents, and
preset tab order for form fields. Navigational aids assist users in understanding the
document without reading completely through it. Bookmarks are especially useful and
can be created from document headings.

Document language

Specifying the document language in a PDF enables some screen readers to switch to
the appropriate language.

Security that doesn't interfere with assistive software

Some PDF authors restrict users from printing, copying, extracting, adding comments, or
editing text. The text of an accessible PDF must be available to a screen reader. You can
use Acrobat to ensure that security settings don't interfere with the screen reader's
ability to convert onscreen text to speech.

For more information about PDF accessibility, see www.webaim.org/techniques/acrobat/.
About tags, accessibility, reading order, and reflow

PDF tags are similar in many ways to XML tags. PDF tags indicate document structure:
which text is a heading, which content makes up a section, which text is a bookmark,
and so on. A logical structure tree of tags represents the organizational structure of the
document. Therefore, tags indicate the reading order and improve navigation,
particularly for long, complex documents without changing the PDF appearance.

Assistive software determines how to present and interpret the content of the document
by using the logical structure tree. Most assistive software depends on document
structure tags to determine the appropriate reading order of text. Document structure
tags let assistive software convey the meaning of images and other content in an
alternate format, such as sound. An untagged document does not have structure
information, and Acrobat must infer a structure based on the Reading Order preference
setting. This situation often results in page items being read in the wrong order or not at
all.

Reflowing a document for viewing on the small screen of a mobile device relies on these
same document structure tags.

Often, Acrobat tags PDFs when you create them. To determine whether a PDF contains
tags, choose File > Properties, and look at the Tagged PDF value in the Advanced pane
of the Description tab.

Reading PDFs with reflow and accessibility features
Setting accessibility preferences

Acrobat provides several preferences that help make the reading of PDFs more
accessible for visually impaired and motion-impaired users. These preferences control
how PDFs appear on the screen and how they are read by a screen reader.

Most preferences related to accessibility are available through the Accessibility Setup
Assistant, which provides on- screen instructions for setting these preferences. Some



preferences that affect accessibility aren't available through the Accessibility Setup
Assistant including preferences in the Reading, Forms, and Multimedia categories. You
can set all preferences in the Preferences dialog box.

The names shown for some preferences in the Accessibility Setup Assistant are different
from the names for the same preferences shown in the Preferences dialog box. Acrobat
Help uses the names shown in the Preferences dialog box.

For more information about accessibility features, see www.adobe.com/accessibility.
Set accessibility preferences with the Accessibility Setup Assistant

Start the Accessibility Setup Assistant by doing one of the following:

Choose Tools > Accessibility > Setup Assistant.

(Windows only) Start Acrobat for the first time while a screen reader or screen magnifier
is running.

Choose the option that is appropriate for your assistive software and devices. The
assistant presents only preferences that are appropriate for your assistive software and
devices, according to the option that you choose.

Follow the on-screen instructions. If you click Cancel at any point, Acrobat uses default
settings for the preferences set by the assistant (not recommended).

Set accessibility preferences with the Preferences dialog box

Set preferences as appropriate for your assistive software and devices in various panels
of the Preferences dialog box.

Accessibility preferences
Accessibility preferences in Accessibility panel
Replace Document Colors

When this preference is selected, you can choose from a list of contrasting color
combinations for text and background, or you can create your own. These settings
correspond to the Use High Contrast Colors For Document Text option in the Accessibility
Setup Assistant.

Always Use Page Layout Style

Corresponds to the Override Page Layout Style option in the Accessibility Setup
Assistant.

Use Document Structure For Tab Order When No Explicit Tab Order Is Specified
Improves navigation of form fields and links in documents that don't specify a tab order.

Always Display The Keyboard Selection Cursor



Select this option if you use a screen magnifier. This preference corresponds to the
Always Display The Keyboard Selection Cursor option in the Accessibility Setup Assistant.

Always Use The System Selection Color

When selected, the default selection color (blue) is overridden with a color that the
system specifies.

Show Portfolios In Files Mode

When selected, shows PDF Portfolio component files and file details in a list. Files mode
provides a better reading experience for people with disabilities, such as mobility
impairments, blindness, and low vision.

Always Use Zoom Setting

Corresponds to the Override Document Zoom option in the Accessibility Setup Assistant.
TODO Does it?

Accessibility preferences in Documents panel
Automatically Save Document Changes To Temporary File Every

When deselected, this preference disables the auto- save action. Each time a PDF is
saved, the screen reader or magnifier must reload the document. This preference
corresponds to the Disable Document Auto-Save option in the Accessibility Setup
Assistant.

Accessibility preferences in Forms panel
Fields Highlight Color and Required Fields Highlight Color

These preferences specify what colors will be used to highlight fillable form fields. They
correspond to the Field Highlight Color and Required Field Highlight Color options in the
Accessibility Setup Assistant.

Auto-Complete

Enables Acrobat to automatically offer to complete some entries in form fields so that
filling form fields requires fewer keystrokes. This preference doesn't correspond to an
option in the Accessibility Setup Assistant.

Accessibility preferences in Internet panel

Display PDF In Browser

Causes PDFs linked to from web pages to open in the web browser instead of a separate
Acrobat window. Deselect this preference for greater control when navigating a

document in a screen reader. This preference corresponds to the Display PDF Documents
In The Web Browser option in the Accessibility Setup Assistant.

Accessibility preferences in Multimedia panel

Show Subtitles When Available



Play Dubbed Audio When Available

Show Supplemental Text Captions When Available

Show Audio Description (Or Video Description, Or Descriptive Video) When Available
These preferences don't correspond to any options in the Accessibility Setup Assistant.
Accessibility preferences in Page Display panel

Zoom

Sets the on-screen magnification of documents and allows low-vision readers to read
reflowed PDFs more easily. This preference corresponds to the Override Document Zoom
option in the Accessibility Setup Assistant.

Smooth Text

Controls anti-aliasing of text. To disable smoothing of text and make text sharper and
easier to read with a screen magnifier, choose None. This preference corresponds to the
Disable Text Smoothing option in the Accessibility Setup Assistant.

Accessibility preferences in Reading panel

Reading Order

Specifies the reading order of documents. The reading order preferences also appear in
the Accessibility Setup Assistant.

Infer Reading Order From Document (Recommended)

Interprets the reading order of untagged documents by using an advanced method of
structure-inference layout analysis.

Left-To-Right, Top-To-Bottom Reading Order

Delivers the text according to its placement on the page, reading from left to right and
then top to bottom. This method is faster than Infer Reading Order From Document. This
method analyzes text only; form fields are ignored and tables aren't recognized as such.
Use Reading Order In Raw Print Stream

Delivers text in the order in which it was recorded in the print stream. This method is
faster than Infer Reading Order From Document. This method analyzes text only; form
fields are ignored and tables aren't recognized as such.

Override The Reading Order In Tagged Documents

Uses the reading order specified in the Reading preferences instead of that specified by
the tag structure of the document. Use this preference only when you encounter
problems in poorly tagged PDFs. This preference corresponds to the Override The

Reading Order In Tagged Documents option in the Accessibility Setup Assistant.

Page Vs Document



This preference determines how much of a document is delivered to a screen reader at a
time. If a PDF isn't tagged, Acrobat may analyze the document and attempt to infer its
structure and reading order, which can take a long time for a long document. You may
want to set Acrobat to deliver only the currently visible page so that it analyzes only a
small piece of the document at a time. This consideration will vary depending on the size
and complexity of the document and on the features of the screen reader. When Acrobat
delivers information to a screen reader, screen magnifier, or other assistive software, it
loads information into a memory buffer that is directly available to the assistive
software. The amount of information that is delivered to the memory buffer can affect
how long Acrobat takes to perform tasks, such as opening the document, advancing to
the next page, changing views, and carrying out commands.

Only Read The Currently Visible Pages

This option is usually best when you use a screen magnifier. It improves performance by
eliminating the need for the software to process parts of the document that aren't
visible. When Acrobat sends only the currently visible pages of a PDF to the memory
buffer, the assistive technology has access to those pages only. It cannot go to another
page until the next page is visible and Acrobat has sent the page information to the
memory buffer. Therefore, if this option is selected, you must use the navigation
features of Acrobat, not those of the assistive technology, to navigate from page to page
in the document. You should also set the Default Page Layout option in preferences to
Single Page if you choose to have Acrobat send only the currently visible pages to the
assistive technology. Because Acrobat sends page information about all visible pages,
the assistive technology receives information about pages that may be only partially
visible (such as the bottom of one page or the top of the next), as well as those pages
that are completely visible. If you use a page display setting other than Single Page,
such as Continuous, and then you display the next page, the technology may not
correctly track which portion of a previous page it has already read aloud. For
instructions on setting the default page layout to Single Page, see "Preferences for
viewing PDFs" on page 14.

This option corresponds to the Only Read The Currently Visible Pages option in the
Accessibility Setup Assistant.

Read The Entire Document

This option can be best if you use a screen reader that has its own navigation and search
tools and that is more familiar to you than the tools in Acrobat. This option corresponds
to the Read The Entire Document At Once option in the Accessibility Setup Assistant.

For Large Documents, Only Read The Currently Visible Pages

This option is selected by default and is usually best if you use a screen reader with long
or complex PDFs. It allows Acrobat to deliver an entire small document but revert to
page-by-page delivery for large documents. This preference corresponds to the For
Large Documents, Only Read The Currently Visible Pages option in the Accessibility
Setup Assistant.

Confirm Before Tagging Documents

When selected, lets the user confirm the options that will be used before Acrobat
prepares an untagged document for reading. Tagging can be a time-consuming
procedure, especially for larger documents. This preference corresponds to the Confirm
Before Tagging Documents option in the Accessibility Setup Assistant.

Read Out Loud Options



Set preferences in this section to control volume, speed, and pitch of the voice used for
Read Out Loud. You can choose to use the default voice or any of the voices provided by
your operating system. You can also use the up and down arrows to read blocks of text.
These preferences do not have corresponding options in the Accessibility Setup
Assistant.

Enable single-key accelerators

You can select some tools and perform some actions with single-key accelerators. Most
keyboard shortcuts in Acrobat don't require that you enable single-key accelerators.

In the Preferences dialog box under Categories, select General, and then select Use
Single-Key Accelerators To Access Tools.

Note: Some screen readers do not work with Acrobat single-key accelerators.
Scroll automatically

The automatic scrolling feature makes it easier to scan through long PDFs, especially
reflowed documents. You can scroll through pages without using keystrokes or mouse
actions.

Choose View > Page Display > Automatically Scroll.

Do any of the following:

To change the scrolling speed to a specific speed, press a number key (9 for fastest, 0
for slowest).

To increase or decrease the scrolling speed, press the Up Arrow or Down Arrow key,
depending on the direction of scrolling.

To reverse the direction of scrolling, press the minus sign (-) key.
To jump to the next or previous page, press the Left Arrow or Right Arrow key.

To stop automatic scrolling, press Esc or choose View > Page Display > Automatically
Scroll again.

Reflow a PDF

You can reflow a PDF to temporarily present it as a single column that is the width of the
document pane. This reflow view can make the document easier to read on a mobile
device or magnified on a standard monitor, without scrolling horizontally to read the
text.

You cannot save, edit, or print a document while it is in Reflow view.

In most cases, only readable text appears in the reflow view. Text that doesn't reflow
includes forms, comments, digital signature fields, and page artifacts, such as page
numbers, headers, and footers. Pages that contain both readable text and form or digital
signature fields don't reflow. Vertical text reflows horizontally.



Acrobat temporarily tags an untagged document before reflowing it. As an author, you
can optimize your PDFs for reflow by tagging them yourself. Tagging ensures that text
blocks reflow and that content follows the appropriate sequences, so readers can follow a
story that spans different pages and columns without other stories interrupting the flow.

To quickly check the reading order of a document, view it in Reflow view.
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Headlngs and columns (left) reflow ina logical reading order (rlght)
Reflow a tagged PDF
Choose View > Zoom > Reflow.

If the Page Display setting is Two-Up before you choose Reflow view, the Page Display
setting automatically becomes Single Page when the document is reflowed. If the Page
Display setting is Two-Up Continuous before you choose Reflow view, the Page Display
setting automatically becomes Continuous when the document is reflowed.

Return to unreflowed view

When in Reflow view, choose View > Zoom > Reflow.
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Instaliningar [Tnst3liningarna Tal, Visa, Ordprediktion, Kontrollera och Skanna kan alla

andras under respektive flik i ClaroReads installningsmeny. Knappen Installningar visas
alltid pa ClaroReads verktygsrad.

Installningar for Tal

Installningar

[

3 Tal

Rést

\f Visa

-I?' Ordprediktion

_alfs,' Stavning

i[; Skanna

|Erik, HOQ 22k, Swedish, Acapela Multimedia
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b |

Volym
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Hastighet

[ ] Paus mellan ord

[ stanna efter mening

| s

Uttal

Spara som
ljudfil
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Avancerat

I_vl'__: Lds ord Ctrl och peka

claro

@

Ok

X

Avbryt

Under fliken Tal kan du valja vilken rost som skall anvéandas av ClaroRead nar
programmet ldser upp text. Du kan ocksa stélla in hastighet och volym pa résten.
ClaroRead kommer med roster av hog kvalitet men fungerar aven med andra SAPI5-
roster som kan vara installerade pa din dator. Detta inkluderar Microsoft systemroster
som Sam eller Anna. Kontakta oss om du vill ha information om ytterligare Acapela- eller
RealSpeak-roster.

Rost

Rast

Erik, HQ 22k, Swedish, Acapela Multimedia

Om du klickar pa nedatpilen bredvid den rést som ar vald for tillfallet kan du se vilka

andra roster du kan valja att anvanda med ClaroRead.

Hastighet & Volym

Andra hastighet och volym genom att flytta kontrollerna at héger eller vénster.




Hastighet

R §

Valym

&

Test-knappen

W

a

Test
i Nar du har andrat installningarna for tal kan du testa dessa innan du klickar

pa OK. Att ladda in en ny rést kan ta en sekund eller tva sd ha talamod! Nar résten har
laddats kan du testa den. Den kommer att sdga "Detta ar ett test av den nuvarande
rosten".

Knappen Uttal

3?
Uttal ) . R . =
Knappen Uttal dppnar uttalslistan for det syntetiska talet. Aven om
RealSpeak-rosterna ar mycket bra finns det tillfédllen nar de inte uttalar orden exakt som
du vill, det kan t ex gélla namn pa personer eller platser. For att fa rosten att uttala

saker som du vill lagger du bara till ordet i uttalslistan tillsammans med en beskrivning
av hur det skall I13ta. Ls Uttalsinstallningar for att ldra dig mer.

Knappen Spara till ljudfil

M

Spara sam
[judfil

Sparar texten till en ljudfil. Se Spara text till [jud.

Knappen Avancerat

-

Avancerat . . e "
Det finns ett flertal avancerade installningar for tal.

Paus mellan ord
[] Paus mellan ord

Om du bockar fér Paus mellan ord kommer résten att géra extra langa pauser mellan
varje ord. Detta kan gdra upplasningen tydligare for vissa anvandare. Om du inte bockar



for detta alternativ ska upplasningen flyta naturligt och ta hansyn till interpunktion, vissa
forkortningar och andra detaljer i texten

Stanna efter mening

|:| Stanna efter mening

Genom att markera kryssrutan "Stanna efter mening" kommer ClaroRead bara att lasa
en mening i taget i Microsoft Word, Adobe Reader eller Internet Explorer. For att lasa
ndsta mening maste du klicka pa knappen Spela igen.

Las ord Ctrl och peka
Lds ord Ctrl och peka

Genom att markera Las ord Ctrl och peka under fliken Tal kan du hoéra ett ord i taget.
For att hora ordet, placera muspekaren dver det och hall ner Ctrl. ClaroRead laser da
upp ordet

Nedan &ar en lista pa vanliga program som Ctrl+peka fungerar med:
Internet Explorer

Microsoft Office (inklusive Word and Outlook)

Mozilla Firefox

Adobe Acrobat Reader

Windows Mail/Outlook Express

Uttalsinstallningar

Uttal =)

Nytt uttal

Ord att ersatta

ClaroRead
Mytt uttal
Claroreed

| Liga till/Ersatt |

Ta bort | @ 6

oK fvbryt

Det finns tillfallen nar text-till-tal rosterna inte uttalar orden precis som du vill, det kan t
ex galla namn p& personer eller geografiska platser. For att fa rosten att uttala ord sa



som du vill lagger du bara till det i uttalslistan tillsammans med en beskrivning av hur
det skall uttalas.

For att 1dgga till ett ord i listan, skriv in ordet du vill &ndra uttalet pa i rutan "Ord att
ersatta". Klicka pa knappen test for att hdra hur den valda résten uttalar ordet.

Nytt uttal
Ord att ersatta
ClaroRead
Mytt uttal
Claroreed

| Légg till/Ersatt |

Skriv i rutan Nytt uttal hur du vill att ordet skall 13ta. Du kan lyssna pa det nya uttalet
innan du lagget till ordet i listan genom att klicka pa knappen Test. Du kan anvanda
enstaka ord eller fraser. Nar du &r néjd med hur det |3ter, klicka pa knappen Ligg
till/Erséatt for att l1agga till det i uttalslistan. Varje gang originaltexten skall l&sas upp
kommer det nu att géras med det nya uttalet.

Vill du &ndra ett ord utan att det paverkar uttalet av andra ord som bérjar med samma
bokstaver kan du ldgga till ett blanksteg i "ord att ersatta". Detta indikeras med ett "#"
sa att du vet att det ar dar. Du kan inte skriva nagot efter detta "#". Till exempel, om du
vill att namnet "Alis" skall uttalas som "Allee" men samtidigt vill du inte att "Alison" ska
bli "Allee-on". Légg da till "Alis " (lagg marke till blanksteget) i rutan "Ord att ersatta".
Nu dndras bara "Alis" men inte "Alison" och detta visas med "Alis#".



Avancerade instdllningar
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Avancerat

Automatiskt tal

[¥] Las vid musmarkering

Las objekt under musen

7] ant 2 [J|1EfFiretox
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(7 Stycke

claro

Q

Tillbaka

@

Ok

Avbryt

I Avancerat kan du reglera vad och hur mycket programmet ska ldsa upp. Du kan ocksa

gora instdllningar for den markérmedfdljning som syns i Microsoft Word under

upplasning av text.

Den automatiska upplasning kontrollerar vad som lases upp och Markérmedfdéljningen
kontrollerar hur markérmedfoéljningen fungerar med Spela.

Automatiskt tal

Automatiskt tal

Lds vid musmarkering

Las objekt under musen

(] ant 2 [/] IE/Firefox
Teck.en Drd
[ Meningar [] Piltangenterna

Upprepa diktering med Dragon
'
NaturallySpeakinq

[¥] Bokstavsljud i@ Man
) Kvinna

Las vid musmarkering

ClaroRead kommer automatiskt att Idsa upp allt du markerar genom att halla ner

vanster musknapp och dra musen 6éver texten. Det betyder att den kommer att lésa i
princip allt och det gér programmet mycket effektivt vid anvdndning pa t ex internet.
OBS! Vid anvandning av denna funktion kan du inte fa markérmedféljning vid upplésning




i Word. Den automatiska uppldsningen kan du avaktivera genom att ta bort bocken
framfor alternativet.

VELLClnln= Rl IROEIC = MClaroRead ar skapat for att
gora det enklare for dig att arbeta med din dator
genom att fa den att tala och gora det enklare att lasa.

Las objekt under musen

ClaroRead laser automatiskt upp alla knappbeskrivningar, menyalternativ och "text-
objekt" som programmet kan komma at. Om du haller musen stilla dver en
verktygsknapp eller en bild dar en beskrivning dyker upp i en ljusgul ruta, lases texten
upp foér dig. Du kan avaktivera funktionen genom att ta bort bocken framfér alternativet.

L3s objekt under musen

] ant 9 IE Firefox

Genom att markera kryssrutan "Allt" kommer varje objekt under muspekaren att lasas
upp, inklusive Windows Startmeny. Markeras bara kryssrutan for "IE/Firefox" kommer
bara objekt pa webbsidor som visas i Internet Explorer, Mozilla Firefox, Safari och Opera
att lasas upp.

Las tecken, ord och meningar

Nar du skriver kan du valja foljande installningar i ClaroRead:

Las varje tecken (=bokstav).

Las varje ord efter mellanslag.

Las varje mening efter stort skiljetecken (punkt, frégetecken, utropstecken).

Detta ar valdigt anvandbart fér att kontrollera stavning och meningsbyggnad under
skapandet av en text och fér att repetera meningarna vartefter texten vaxer fram. Vart
och ett av alternativen gar att avaktivera pd om du inte har anvandning fér dem. Om du
markerar att du vill ha varje tecken upplast kan du valja om WordRead Plus ska lasa
bokstavhamn eller bokstavsljud. Har du valt bokstavsljud kan du aven valja mellan
manlig och kvinnlig rést.

Piltangenter i Word

Nar du flyttar runt i de flesta falt med text, inklusive Microsoft Word, med hjalp av
piltangenterna p& ditt tangentbord (i stillet fér med musen) kan du genom att aktivera
"Piltangenter i Word" valja om ClaroRead samtidigt skall lasa upp texten.

N&r du anvédnder piltangenterna for att forflytta dig uppat eller nedat i dokumentet ldser
ClaroRead hela raden med text. P detta satt kan du fa ett helt dokument upplast for
dig, rad for rad, bara genom att anvanda pil ned.

Genom att halla ned Ctrl tillsammans med héger eller vanster piltangent léser
programmet ordet narmast textmarkoren.



Genom att trycka pa héger- eller vansterpil |dses nasta bokstav i ordet upp.

Genom att halla ner Ctrl samtidigt som man trycker p& pil upp eller ned far man ett helt
stycke i taget upplast.

Repetering av Dragon NaturallySpeaking

Upprepa diktering med Dragon
V
MaturallySpeaking

Dikterar du text med Dragon NaturallySpeaking version 7 eller senare kan ClaroRead
repetera varje ord eller fras som Dragon kd@nner igen. Detta ger 6kad sakerhet och
precision i dikteringen genom att bekrafta att Dragon har tolkat ditt tal ratt.

Markormedfoljning

e Ga till Installningar fér markérmedféljning

Markormedfoljning vid upplasning
Markering

(i ord () Rullande

= @ Mening () Stycke

P

Ingen bakgrundsfarg

-

Teckenfarg

DMEningsfnkusering

Nar ClaroRead laser en text i ett Microsoft Word-dokument kan du valja att markera
texten vartefter den lases upp. Rdsten ar synkroniserad med det markerade ordet eller
meningen vilket ger en ytterligare hjalp i Iasningen av texten.

Du kan vélja att markera ett ord i taget, varje mening eller hela stycket. Du kan ocksa
géra farginstallningar bade fér bakgrunden och teckenfirgen.

Rullande markering betyder att ett ord blir markerat ndr det ldses upp men fortsatter att
vara markerat tills dess att hela meningen har lasts upp. Detta reducerar blinkandet av
ord som lases upp.

Du kan goéra sa att text i Word som inte lases upp blir "nedtonad" i stéllet for att
markera texten som blir upplast. Du kanske tycker att detta ar behagligare samtidigt
som det fortfarande |3ter dig félja med i texten. Markera "Meningsfokusering" for att sla
pa denna funktion.
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Avbryt

Under fliken Visa kan du &ndra knapparnas utseende och storlek p& ClaroRead

verktygsrad. For att lagga till en knapp i verktygsraden klickar du pa den s3 att den ser
"nedtryckt" ut. For att ta bort en knapp klickar du pa den sa att den ser "upphdjd" ut.

Knappar
L =
~ . 1 = ¥
g abe, L E
Spela Stavning Hjdlp Avstand Spara
+ + = = ! . a -I? I‘ -}_-.}
Extra Homofoner Typsnitt Prediktion

verktygsradens storlek ytterligare.

Du kan &ndra storleken pa ClaroRead verktygsrad till liten, medium eller stor. Du kan

valja att visa en forklarande text under varje knapp - genom att ta bort texten minskas



Verktygsrad

i) Liten

(71 Mellan

i@ Stor

‘u"isa beskrivningar

Las verktygsrad till aktivt fanster

Du kan vélja att ha verktygsraden "flytande" sd att du kan klicka ldngst upp pa
verktygsraden och dra den vart du vill pd skdrmen. Ar verktygsraden inte flytande, 18ser
den sig till det dvre hégra hérnet pa det fonster som ar aktivt. For att ta bort ClaroRead
verktygsrad men fortfarande kéra programmet i bakgrunden, se avsnittet Flytta och I3sa
ClaroRead verktygsrad.

Du kan ocksa &ndra utseendet pa ClaroRead till ett av tre teman. Du kan valja mellan

Klassisk, Gra och Silver:
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Ordprediktion

P& fliken Ordprediktion kan du aktivera ordprediktionen, vélja din ordlista och dndra dina

ordlistor.

Installningar
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Anpassa lexikon

|¥| Lgg automatiskt till nya ord
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Anvand ordprediktion

[] AnvéEnd ordprediktion

Med "Anvand ordprediktion" aktiverar eller avaktiverar du ordprediktionen permanent.
Knappen Ordprediktion aktiverar eller avaktiverar ordprediktionen temporart.

ordfil

Ordfil

Ordlista med 1000 ord (Svenska)

Med denna dropplista valjer du vilken ordlista du vill anvanda.

Prediktionslistans instdllningar

Du kan vélja att fa orden listade antingen alfabetiskt eller efter sannolikhet.

Du kan aven valja att visa "ignorerade" ord i prediktionslistan. Till exempel, om det finns
en lista med féreslagna ord, t.ex. cathode, cattle, catastrophe, catalogue, cattery - och
du valjer att visa ignorerade ord sker foljande; Nar du skriver "ca" visas de fem orden
ovan. Men nar du skriver nasta bokstav ignoreras i vanliga fall de ord som tidigare




visades eftersom du redan har férkastat dem. Med "visa ignorerade ord" markerat
kommer de fem orden ovan fortfarande att visas om du skriver "t" efter "ca".

Andra firger i prediktionslistan

‘_, Text #_,

Teckenfarg Bakgrund

For att géra prediktionslistan lattare att lasa kan du dndra farg pd bade text och
bakgrund.

Anpassa prediktionen

Det finns ett antal installningar som kan anvandas for att anpassa ordprediktionens
basordlista med de ord som du har anvant i dina dokument.

Anpassa lexikon

Ldgg automatiskt till nya ord

Gar en rattstavningskontroll innan nya ord
ldaas till

Lagg marke till anvdnd ordfoljd
Sortera utifran antalet anvinda ord

|:| Spara ordbok nar du avslutar

Nar du skriver nya ord kan dessa automatiskt laggas till i prediktionsordlistan. Vi
rekommenderar att du ocksd markerar "Gor en rattstavningskontroll innan nya ord ldggs
till" dd detta forhindrar att stavfel 1dggs till i ordlistan

N&r du har skrivit fardigt ett ord eller trycker pa mellanslagstangenten férsdker
ClaroRead komma med férslag pa nasta ord. Om du markerar "Ldgg mérke till anvand
ordfdljd" kommer ditt val fran denna lista att noteras och ord som du véljer ofta kommer
att flyttas upp i listan.

Om du markerar "Sortera frekvensker" kommer ClaroRead att nar du avslutat ett ord
Oka sannolikheten att det kommer hdégre upp i ordprediktionslistan.

Den uppdaterade ordboken kommer att sparas nar du avslutar ClaroRead om du har
markerat alternativet "Spara ordbok nar du avslutar". Det kan finnas tillféllen nar du inte
vill spara @andringarna, vilket @r anledningen till att vi erbjuder alternativet.

Avancerad traning av prediktionsordboken

Det gar att redigera och trdna ordprediktionen direkt fran ord som finns i skapade
Microsoft Word dokument i Programmet Avancerade installningar.



Kontrollfunktionen

Du kan andra instéllningarna fér kontrollfunktionen under fliken Stavning.
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Du kan aktivera eller avaktivera stavning och ordférklaringar i Kontroll fonstret.

Du kan aktivera eller avaktivera delar av talet (verb, adjektiv osv.) ocksa i
stavningskontrollfénstret.

Du kan aktivera eller avaktivera avstavningen av ord i nedre delen av
stavningskontrollfénstret.

Du kan aktivera eller avaktivera visa bilder i kontroll fonstret

Bara for [ander dar Ordlistor foljer med: "Ordférklaringar" och "Visa alltid
ordférklaringar" rutorna kontrollerar fonstret for ordférklaringar. "Ordférklaringar™
kontrollerar ifall ordférklaringar ska visas 6éverhuvudtaget och "Visa alltid
ordférklaringar" kontrollerar ifall ordférklaringarna alltid ska visas och om de kan flyttas
till en viss plats pa skarmen eller om du ska félja musen.

Homofoninstdllningar

Om du klickar p& Homofon instéllningar kommer féljande dialog upp:
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Vill du ignorera vissa homofoner fran ClaroReads lista med homofoner markerar du
kryssrutan bredvid ordet.

Markera "Kontrollera nar du skriver" for att markera homofoner direkt nar de skrivs i
Microsoft Word. Nar detta sker ger datorn &ven ifran sig en ljudsignal.

Markera "Visa homofoner" for att visa fliken homofoner kontrollfénstret.
Du kan valja med vilken farg som skall anvandas for att markera homofoner.

Du kan redigera homofonlistan i programmet Avancerade instéallningar.




Tangentinstallningar och kortkommandon

Tangentinstallningar

Dﬁvaktivera Caps Lock

Dﬁvaktivera Insert

Mum Lock

@ Standardlige
1 Alttid pa

() Alltid av

Tangentinstallningar ar en del av installningarna for Stavningskontroll och tangentbord.
Detta ar en anvandbar funktion som gor att du undviker att SKRIVA MED STORA
BOKSTAVER for att du rakade komma at CAPS LOCK av misstag eller skriva over text
darfor att du har r@kat trycka pa Insert.

Markera kryssrutorna om du vill inaktivera tangenterna CAPS LOCK och Insert nar
ClaroRead anvands.

Du kan vélja att I1&ta NumLock fungera som vanligt, l1ata den alltid vara pa (fér inmatning
av siffror) eller alltid avstéangd for att kunna anvanda tangenternas alternativa
funktioner.

For att nar som helst stoppa upplasningen kan du halla ned Ctrl-tangenten.
Kortkommandon

Det finns nagra kortkommandon som kan anvéandas istéllet for att behdver forlita sig pa
musen. Kortkommandona ar:

-

Spela Spela

Stopp Stopp

oy

UF9 = Kontroll | entrol

Viza homofoner

Markera homofoner

X Ta bort markering av homo foner

Ta bort markering av homofoner
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S—F6 = Byter kortkommandon till Microsoft Word

Las nasta mening

{3}

Oppna instéllningar [ Instéliningar

See®ICTRL + upp/ner = Laser hela féoregaende/nasta stycke



Skanning
Finns i bade ClaroRead Plus och Pro.

Fliken Skanna visas nedanfor.
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Format

N&r du skannar ett dokument kan du vélja att antingen behalla den ursprungliga

formateringen eller férenkla formatet till en enda kolumn med text. Du kan antingen

inkludera bilderna fran originaldokumentet i det inskannade dokumentet eller ignorera

dem.

Format

/@ Behall ursprungligt format

" Farenkla formatet

[ viza bilder




Skanningssprak

Du kan &ndra installningarna fér OCR-behandlingen (OCR star for Optical Character
Recognition eller pd svenska, optisk teckenigenkdnning). Det &r som standard satt till
svenska. Om du till exempel skall skanna in en fransk text behdver du tala om for
ClaroRead att det ar fransk text det kommer att ta emot. Gor detta genom att valja
sprak:

Skannar

OCR-sprak

swenska v]

finska
danska
islandska |

CoE s T P

Forhandsgranska den inskannade bilden

|:| Farhandsgranska inskannad bild

Markera "Férhandsgranska inskannad bild" pd Skanna fliken i instéllningar for att fa ett
forhandsgranskningsfonster att 6ppna sig. Se Férhandsgranska.

Korrekturlads fore konvertering till text (endast ClaroRead Pro)

Korrekturlds fare konvertering till text

Efter forhandsgranskningen kan du valja att korrekturldsa dina inskannade sidor. Du kan
korrigera eventuella igenkanningsfel eller lagga till olika alternativ. Markera "Korrekturlas
fore konvertering till text" for att dppna fonstret ndsta gang du skannar. Se Korrekturlas.

Visa resultat
Qppna med standardprogram

Om du skannar nar Microsoft Word inte ar det aktiva programmet visas en dialogruta
som fragar om du vill spara resultatet som en fil. Om "Oppna med standardprogram" &r
valt éppnas den sparade filen direkt i det program som &r associerat med den filtypen.

Instdllningsguiden for skanner

oy Vilj bildldsare

Innan du skannar férsta gangen bér du ga igenom instéliningsguiden fér skanner for att
forsékra dig om att ClaroRead kan komunicera med din skanner. ClaroRead stodjer ett
stort antal olika skannrar.

Kora installningsguiden for skanner

Vilka fonster som visas beror pa vilken skanner och vilka andra enheter som du har
anslutna till din PC. De fdljande bilderna visar de olika fonstren i guiden. Det forsta



frdgar om du vill ladda ner den senaste databasen med skannrar. Vi rekommenderar att
du véljer Nej. Klicka p@ Nasta

2% Installationsguide fér ScanSoft bildldsare w

Den har guiden hjglper dig att valia och testa den
bildliasare eller digitala kamera som ska anvandas med
programmet.

Muvarande val:

ﬂlngen bildlasare

Mar du valjer en enhet hamtar guiden de installningar
som passar bast fran databasen, som installeras
tillzammans med guiden. Databasen innehaller
drivnutinsinformation for aktuella och populara bildiasare

och kameror.
Vill du ladda hem den senaste bildidsardatabasen fran
ScanSoft?

(T da © e

Ar "Ingen bildldsare" vald visas féljande fénster, klicka pa Nésta.

2 Installationsguide for ScanSoft bildldsare ﬁ

Muvarande val:
Ingen bildlasare

Valj vad du vill gora och ldicka pa Nasta.

Testa den aktuela bildlasaren sler dioitalkameran
Anvand de aktuellz installningama med den akiueilz
enneten

Med det forsta atemativet kan du installera och testa en

bildlasare for forsta aangen eller byta till en annan
bildlasarenhet .

Enheter som du vill installera med ScanSoft-produkden
maste redan ha installerats och testats pa datom med
bildidsarenhetens eget installationsprogram.

Nu skall det visas en lista pa tillgdngliga skannerdrivrutiner pd din PC. De som visas hér
ar bara ett exempel. Du kommer antagligen att se andra namn. Finns det flera
drivrutiner féor samma enhet (skanner) ar det rekommenderat att ta TWAIN-drivrutinen.
Valj drivrutin och klicka pa OK.



Tillgangliga bildlssare S

W 3l bildlazare i listan. Du kan bara lagoa till en bildlazarenhet i taget. Om du il
installera en enket bl ko du guiden pd rtt,

TwiAlM A, 1515 Anhat

Tl OpticSlim M12
TwialM: CanoScan LIDE 200
TwialM: CanoScan LIDE 25

Thw/AIM: OpticB ook 3600

Obsl Undwvik att anvanda en driviutin zom kallas for "TWHAIM: WWA- " om du inke ar
zaker pa att den passar hill enheten.

| Ok | | Awbwt | | Higlp:r |

L.

Du skall nu se den valda skannerdrivrutinen i listan, se till att den &r vald och klicka pa
Nasta.

2% Installationsguide fér ScanSoft bildldsare Iﬁ

alj den bildiasare som du vill anvanda med ScanSoft-produkden. Om den
har installerats men inte finns med i listan, kicka pa Laga till bildiasare ..

Ingen bildliasare

Ligg til bildisare.. | | Tabort bildisare

Standardbildlasare
TWAIN: Lesernark 3600-4600 Seres TWAIN

< Back ]| ot = |[ Cancel

e

Déarefter maste du vélja om du vill testa skannern eller inte. Du kan vélja Ja, Nej eller
Aterstall ursprungliga instéliningar. I de flesta fall, den rekommenderade (férvalda)
installningen.



2 Installationsguide for ScanSoft bildldsare ﬁ

Bildlasaren eller den digitala kameran ar nu installd pa:
TWAIN: Lexmark 3600-4600 Senes TWAIN Rev 12.0

Bildlasaren eller kameran finns inte i databasen for
installation av bildlasare. Du bor kora
diagnostiktestema for att konfigurera den far
anvandning med:

ClaroRead

¢Back || Net> | | Cancel |

2% Installationsguide fér ScanSoft bildldsare ﬁ

Installationsguiden for bildlasare har korfigurerst
bildlasaren for anvandning med:

ClaroRead

Obs! En del test hoppades dver. Om du far problem med
inlasningen anvander du guiden igen och kor alla tester.

<Back |i Fiish | | Cancel

Klicka p& Slutfor for att avsluta guiden. ClaroRead skall nu fungera tillsammans med din
valda skanner. Vélj Skanna fran papper fran menyn Skanna. Ser du féljande
startskarm sa fungerar skanningsfunktionen.

[ & ScandText ﬁ

Skannar...




Programmet Avancerade installningar

Programmet Avancerade instéllningar later dig andra homofoner och svara ord, tréna
upp och andra instéllningarna fér ordprediktionen. Du hittar det under knappen Extra pa
ClaroReads verktygsrad.

Programmet Avancerade installningar har fyra flikar:

Allmant

+# ClaroRead Advanced Settings Editor

I.JI Allmant ﬁ Homofoner | IJ Tréna prediktionen |  abg| Stavning
Teckensnitt och bakgrund Tal
Typsnitt1 | Tiresias PCfont -| _
|+f| Aktivera click-and-play i Internet Explorer
Typsnitt 2 |Trebuchet MS - |
Typsnitt 3 ||'v'|j-::msnﬂ Sans Senf v] Installningar
I:l'_l Aterstill bakgrundsfarg vid avslut
‘ Exportera ‘ ‘ Impartera
Ordprediktion
IE' Prediktion av nasta ord
Program
[T| Fénstrat alitid synligt
Sok efter
Firesla endast efter tecken: 1 @] uppdateringar

b

Under Teckensnitt och bakgrund kan du valja vilka teckensnitt som skall visas under
knappen Typsnitt pa ClaroReads verktygsrad. Du kan ocksa vélja att bakgrundsfargen
skall 3terstallas nar du avslutar ClaroRead.

Vid Tal kan du valja om Internet Explorer skall stédja click-and-play. Detta ar nar du
klickar pa en del av en webbsida i Internet Explorer och ett svart streck visar vad du har
valt: du kan klicka p& knappen Spela och sidan kommer att bli upplast med
markdrmedfdljning. Om du avmarkerar rutan kommer strecket inte att visas, Spela laser
bara upp vad som finns i Windows Urklippshanterare och du kan bara ldsa upp
webbsidor med hjalp av "Las vid musmarkering" och "Las objekt under musen
(IE/Firefox)".

I avsnittet Ordprediktion kan du gora sa att prediktionslistan alltid visas, dven om det
inte finns nagra férslag pa ord, genom att kryssa i "Fénstret alltid synligt". Du kan
anvénda detta tillsammans med att hogerklicka pa fonstret for att skapa ett permanent




prediktionsfonster for dig sjalv. "Prediktion av nasta ord" betyder att ClaroRead kommer
att foresld nasta ord nar du trycker pa mellanslagstangenten. "Féresla endast efter
tecken" far ClaroRead att visa forslag endast efter ett visst antal tecken har skrivits in, i
stallet for direkt efter det forsta tecknet.

Klicka pa OK for att spara andringarna.

Homofoner

+# ClarcRead Advanced Settings Editor
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_abg) Stavning

Homofoner & Svara ord

ﬁh.ra I Ursprungligt ord

in =
dnda 4499

att

m

bick ‘ Alternativ
bar

beck = i
black
bleck
bar
chiffer

egq
elva
an
::tda fagel
farga

farja

gdrna

gjord i

Beskrivning

Q| 4| X | L

Laga till Andra Radera Hjalp

oK

L9

Under fliken Homofoner kan du se, lagga till, redigera och radera ord i listan med
homofoner och svara ord. For att titta pa ett homofon, klicka bara pa det i listan till
vanster och detaljerna kommer att visas till héger.

Om du vill redigera ett ord, valj det i listan och klicka pa knappen "Andra", féljande
skarm visas:




+# Andra valt ord ﬁ

Ord att dndra
Hog

Alternativa ord (separera ord med ett komma):
€4aqg

Beskrivning:
fagel

ok || avbryt

L

Gor de andringar du 6nskar och klicka pa OK.

For att 1dgga till ett ord, klicka p@ knappen "L&gg till" pa fliken homofoner, fyll i
formularet och klicka pa OK. For att radera ett ord, vélj det i listan till vénsteroch klicka
pa knappen "Radera".

Klicka pa OK for att spara andringarna.



Trana prediktionen

+# ClarcRead Advanced Settings Editor tﬁ

"’TI Allmant

3_3 Homofoner '::II Trana prediktionen abg Stavning
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Under fliken Trana prediktionen kan du andra de ord som anvands i prediktionsordlistan
och trana upp prediktionen med hjalp av Worddokument.

ClaroRead har tva prediktionsordlistor installerade: 1000-ord och 3000-ord. du véljer
vilken du vill anvénda i rullgardinsmenyn langst upp till vanster i fliken Trana
prediktionen.

Orden i den valda ordboken visas i listan till vanster och du kan lagga till eller ta bort ord
med knapparna "Lagg till" och "ta bort".

For att tréna upp prediktionen med hjélp av Word, maste du férst dppna det
Wordokument du vill anvanda.

Genom att vélja "Uppdatera nya ord" l4ggs nya ord fran ditt dppnade Worddokument till
i den valda prediktionsordlistan.

Valj "Sortera utifran antalet anvanda ord" for att spara information om hur ofta ett ord
forekommer i det nuvarande dokumentet. Detta gor att ClaroRead kan visa ord som du
ofta anvander hogre upp i listan med féreslagna ord.

Valj "Lagg marke till anvand ordféljd" for att spara information om i vilken ordning orden
kommer i ditt dokument. Detta gér att ClaroRead kan féresla ord som ofta férekommer
efter det ord som du for tillfallet skriver.



Vill du spara de nuvarande prediktionsinstdllningarna som en ny prediktionsordbok,
klicka pa "Ny ordbok" och valj ett namn for din fil.

Stavningsfliken
+# ClaroRead Advanced Settings Editor M
:_JI Allmant ﬁ Homofoner '.jI Trana prediktionen  abg| Stavning
Dina stavningsférandringar Kandidater
LU e L i:"_l Samla stavningsinformation
abbonemang » |abonnemang - L
address = |{adress = o T
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bakrund bakgrund
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Denna flik visar stavningar som har hittats och korrigerats at dig av ClaroRead och
Word. De senaste rattningarna visas i "Dina stavningsandringar". Om du i Word
anvénder ndgot av orden och klickar pa knappen Kontroll visas ordet med din
korrigerade stavning dverst i listan med férslag. Du kan manuellt lagga till och ta bort
ord fran listan med knapparna "L&gg till" och "Ta bort". Till exempel, om du vet att du
ofta stavar "hemma" som "hema" kan du lagga till "hema" och "hemma" och ClaroRead
kommer att féresla dndringen nér du klickar pa Kontroll. Du kan ga ett steg langre
genom att klicka pa knappen Autokorrigering, denna lagger till alla dina
stavningskorrigeringar till Words Autokorrigering och en egen ordlista. Detta betyder att
nar du stavar fel till ett ord i Word (till exempel "hema") @ndrar Word det till "hemma"
utan att du behéver géra ndgonting och om du hégerklickar pd "hema" visas "hemma"
som ett forslag.

N&r du i Word réttar stavningen med kontrollfunktionen kommer ClaroRead ihag
dndringen sa att du kan anvanda den senare. Andringarna hamnar i avdelningen
kandidater. Ordet och &ndringen visas. Om du véljer ett par och klickar p& Skicka flyttas
paret till listan Dina stavningsférandringar och visas nar du anvander kontrollfunktionen.
Om du inte vill anvénda dig av en korrigering klickar du p& Ta bort (eller Ta bort alla).
Vill du ha mer information om kandidaterna, inklusive nar du sist gjorde andringen och
hur ofta du gér den, klicka pa Rapport for att f& en rapport som du kan sortera och
skriva ut med dina stavningskorrigeringar.



